Cantor

Georg Cantor (1845–1918)

Cantor User’s Manual
David Marcus

Version 14.7
November 6, 2022

Cantor and Ratings Central are not free; see Appendix G on page 99.

There is no warranty for Cantor. We provide Cantor “as is”, without
warranty of any kind, either express or implied, including, but not
limited to, the implied warranties of merchantability or fitness for a
particular purpose. The entire risk as to the quality and performance
of Cantor is with you. In no event will we be liable to you for damages,
including any general, special, incidental or consequential damages
arising out of any use of Cantor or out of any inability to use Cantor.

Copyright © 2022 David J. Marcus
All rights reserved.

Contents
List of Figures

9

List of Tables

11

Chapter 1. Introduction
1. Installation
1.1. Hardware and Software Requirements
1.2. Files
1.3. Database Folder
1.4. Making Backups
1.5. Upgrading
1.6. Restoring Backups
1.7. Minor Issues
2. Language
3. Notation

13
13
13
13
14
14
14
15
15
15
16

Chapter 2.

17

Overview

Chapter 3. Cantor Menu
1. Exit
2. Set Up
2.1. Director
2.2. List Database Folder
3. Set Up Internet
3.1. Email
3.2. Web Proxy Server
3.3. Test
4. Select Printer
5. Visit Website
6. Display Version

27
27
27
27
29
29
30
31
31
32
32
32

Chapter 4. Lists Menu
1. Import
1.1. Automatic Download
1.2. Manual Download
1.3. USATT Rating List
1.4. Import Errors
2. Browse Rating
3. Browse Club

35
35
36
36
37
38
38
38
5

6

CONTENTS

Chapter 5. Events Menu
1. Multiple-Day Events
2. Subevents
3. Select Current
3.1. Browse
3.2. Edit
4. Submit
4.1. Submit Events
4.2. Previous Submissions
5. Import
5.1. Ratings Central API

39
39
40
40
41
42
44
44
45
45
47

Chapter 6. Players Menu
1. Modify
1.1. Browse
1.2. Edit
1.3. Rating-List Browser
2. Copy from Event
3. Import
4. Print

49
49
49
50
55
56
57
58

Chapter 7. Main Window
1. New Result
2. Modify Result
3. Print Results

61
62
63
63

Chapter 8.

65

Club Browser

Chapter 9. Unrated Players
1. Rating Scale
2. The Fewer Priors the Better
3. Player Priors
4. Event Prior
5. Rating System Floor

67
67
68
68
69
70

Chapter 10. Submitting Events
1. Duplicate Players
2. Wrong Date or Director ID
3. Lost Files

71
72
74
74

Chapter 11.

Mistakes and Errors

77

Appendix A.

Who Was Cantor?

79

Appendix B.

Screen Resolution and Font Size

81

Appendix C. User Interface
1. Persistence
2. Basic Window Operation
3. Scroll Bars

83
83
83
83

CONTENTS

4.
5.
6.
7.
8.
9.

Focus
Disabled and Read-Only Controls
The Main Menu
Enter Key
Accelerator Keys
Grids
9.1. Incremental Search
10. Drop-Down List
11. List Box
12. Dates and Date Fields
12.1. Calendar
13. Buttons and Radio Buttons
14. Button Edits
15. Check Boxes
16. Navigator Bar
17. Notebooks
18. Edit Fields
19. Progress Bars

7

84
84
85
86
86
87
87
88
88
88
89
89
89
89
90
90
90
90

Appendix D. Database Folder
1. Specifying the Database Folder
2. Multiple Director IDs

93
93
94

Appendix E.

Crashes and Bugs

95

Appendix F.

Data Safety

97

Appendix G.

Cost

99

Appendix.

Index

101

List of Figures
1

Quick-start window

17

2

Main window

18

3

Import-lists window

18

4

Select-current-event window

19

5

Edit-event page

20

6

Club browser

20

7

Event grid

21

8

Main window showing event name and date

21

9

Modify-players window

22

10 Rating-list browser

22

11 Edit-player page

23

12 Player grid

24

13 New-result window

24

14 Result being entered

25

15 Main window showing result

25

16 About to delete result

26

1

Set-up window

27

2

Set-up-Internet window

30

3

Test-sent window

31

4

Test reply email

32

5

Select-printer window

32

6

Version window

33

1

Import-lists window

35

2

Download window

36

3

Sample USATT rating list

37

4

Import-lists error window

38

1

Select-current-event window

41

2

Edit-event page

42

3

Submit-events window

44
9

10

LIST OF FIGURES

4

Import-events window

45

1

Modify-players window

49

2

Edit-player page

51

3

Rating-list browser

55

4

Copy-players-from-event window

56

5

Import-players window

57

6

Print-lists window

59

7

Player list sorted by name

59

8

Player list sorted by rating

59

1

Main window

61

2

Result window

62

3

Result list

63

1

Club browser

65

1

Event-processed email

73

2

Problem email

74

1

Error-message window

77

1

Window showing disabled and read-only controls

84

2

The Modify Result button is the default button

86

3

Progress bar

91

1

Crash window

95

List of Tables
1

Main-window shortcut keys

85

11

CHAPTER 1

Introduction
Cantor is the front end for Ratings Central. Cantor allows you to easily submit
results and corrections to Ratings Central. You can see all the results and ratings
on the Ratings Central website at www.ratingscentral.com. Cantor and Ratings
Central are not free; see Appendix G on page 99.
The only documentation for Cantor is this manual—there is no Help. You
will probably want to print this manual (double-sided) and place it in a three-ring
binder. If you read this manual, you will find Cantor to be very easy to use. Chapter 2 on page 17 contains an overview in the form of a tutorial. The following
chapters of the manual are organized around each of the item’s in Cantor’s main
menu. These are followed by chapters on Cantor’s main window and club browser.
Then come chapters on unrated players, submitting events, and mistakes and errors. The appendices cover Georg Cantor, screen resolution and font size, detailed
information on the user interface, how Cantor finds the database folder, crashes
and bugs, and cost.
1. Installation
This section discusses Cantor’s hardware and software requirements, what
happens when you install Cantor, how to upgrade Cantor, and how to back up
and restore your data.
1.1. Hardware and Software Requirements. Cantor runs on Windows 11, 10,
8.1, 8, 7. Any computer hardware should work. You can also run it on a Mac or
Linux using Wine, CrossOver, Parallels, etc. To submit results to Ratings Central,
you will need a connection to the Internet (see Section 3 on page 29 for more information). You do not need to be connected to the Internet while you are entering
results into Cantor. So, you could enter the results at your club and then submit
the results later.
1.2. Files. The installation program (e.g., Cantor_14.7_Setup.exe) creates
a program folder (e.g., C:\Program Files (x86)\RatingsCentral\Cantor) and
places the executable (Cantor.exe), User’s Manual (Cantor.pdf), sample rating
list (SampleRatingList.csv), sample club list (SampleClubList.csv), license file
(License.txt), OpenSSL files (libeay32.dll, ssleay32.dll; these files are only needed if
you check the ::Cantor > Set Up Internet > Email > Use TLS check box), read-me file
(ReadMe.txt), and a file detailing the changes in each version (VersionHistory.txt)
in the program folder. It adds Cantor and the User’s Manual to the “Start” menu
and optionally to the desktop. That’s all that the installation program does.
13
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Note that the sample rating list and club list files are just samples—they do
not contain real players or clubs. Their only purpose is to let you work through the
overview section. Do not use them when running a real event that you will submit
to Ratings Central.
When you start Cantor, it will create the following set of database files in the
database folder: Club.nx1, Configuration.nx1, Event.nx1, Player.nx1, RatingList.
nx1, Result.nx1, and Submission.nx1. It will also create an nxTrans.cfg file.
The nxTrans.cfg file is used by the database library that Cantor uses, but the
file is not essential. If it is erased, it will be recreated.
The Club.nx1 and RatingList.nx1 files only contain the data from whatever club
list and rating list that you’ve imported. Also, it is possible to keep these two files
in a different folder than the other database files (see Section 2.2 on page 29).
The remaining five files with the nx1 extension contain the information for all
the events, players, and results. They are interdependent, so you should treat them
as a group.
1.3. Database Folder. The location of the database folder is controlled by the
shortcut that you use to start Cantor. The shortcuts that the installer creates will
put this folder in your app data folder, e.g., C:\Users\YourUserName\AppData\
Roaming\RatingsCentral\Cantor. Note that the default location of the database
folder has been different in different versions of Cantor.
The default location of the database folder is where Microsoft thinks apps
should put their files. It is probably a good idea to change the location to one that
is more convenient so that you can easily back up the files. See Appendix D on
page 93 for how to tell Cantor where your database folder is.
See Appendix F on page 97 for advice on where you should put the database
folder.
1.4. Making Backups. Each time that you use Cantor, be sure to make backup
copies of the files in your database folder, and keep the copies in a safe place. To
make a backup, close Cantor, then copy the files.
As noted above, you don’t need to back up all the files in the database folder,
but it is simpler and safer to back them all up. If you don’t want to back up
the Club.nx1 and RatingList.nx1 files (since they are not needed when restoring a
backup), you can tell Cantor to put these files in a different folder. See Section 2.2
on page 29.
You are responsible for making corrections (including removing duplicate players) for any events that you submit. Such corrections may be necessary long after
an event is submitted. Therefore you are expected to back up your database files
and retain them indefinitely. If you get a new computer, be sure to back up the files
on the old computer and transfer them to the new computer. If you lose your database files, Ratings Central can send you replacements; see Section 3 on page 74.
If you are no longer able to be responsible for your events, see Section 2.1.1 on
page 28.
1.5. Upgrading. The format of the database files in a new major version of
Cantor will be different than in previous versions. However, the file format will not
change in a minor version release. You do not need to uninstall a previous version

2. LANGUAGE

15

when installing a new version (this applies to both major and minor versions). By
default, the installation program will install a new version so that it replaces an
older version. But, please make sure that your shortcuts still point to the location
of your database folder.
In general, Cantor can update database files from previous versions to the
current version’s format. It will do this automatically when it starts if the files in
the database folder are from a previous version. Please back up your database files
before letting Cantor update them.
Cantor doesn’t bother to update the Club.nx1 and RatingList.nx1 files since
they only contain the same data that is in the club and rating lists that you imported. If Cantor finds that these files are from a different version, it will simply
delete them and create new, empty ones that are for the current version.
If you have database files from Cantor version 1 or 2 and you used different
director IDs for different events, then Cantor won’t be able to update the files.
In this case, keep your old version of Cantor to access the old files. If you have
multiple versions of Cantor installed, be sure that you don’t enter the same event
into more than one version.
If you upgrade from a version before version 10 to version 10 or later, you will
need to reenter your director, email (SMTP), and Web-proxy-server passwords. This
is because the way that these are stored changed in version 10.
1.6. Restoring Backups. To restore a backup (to the same or a different computer), you need to have Cantor installed on the computer that you are restoring
to. You then need to determine (or change) the location of the database folder. See
Section 1.3 on the facing page and Appendix D on page 93. Finally, you need to
copy the files from your backup to the database folder. You can then start Cantor.
The location of the database folder is displayed in the status bar at the bottom of
Cantor’s main window (see Chapter 7 on page 61). Make sure that the status bar
displays the folder that you copied the files to.
1.7. Minor Issues. If you move the database files from one computer to another by writing them to a CD or DVD, or if you restore them from a backup on
a CD or DVD, the files may end up being read-only. When you start Cantor, you
will get an error message to this effect. To fix the problem, right-click the files in
Windows Explorer, select Properties, and uncheck the Read-only check box.
Sometimes, if you move the database files to a different version of Windows
or if Windows has been updated, Cantor will need to do a database pack when it
starts. If it does, you may see a slight delay when Cantor starts. The reason is that
Windows is telling the database that the way it sorts strings may be in a slightly
different order from the other version of Windows, and the database wants to make
sure that everything will work correctly.
2. Language
Cantor and Ratings Central use the Unicode character set. Cantor versions
before version 10 used the ISO 8859-1 (Latin 1) character set (en.wikipedia.org/
wiki/ISO_8859-1). If you have database files from an ISO 8859-1 version of Cantor,
it is best to upgrade to a Unicode version. An ISO 8859-1 version of Cantor will still
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be able to submit events to Ratings Central, but will not be able to use characters
that are not in the ISO 8859-1 character set. If you use an ISO 8859-1 version
to download club and rating lists from the Ratings Central website, characters in
those lists that are not in the ISO 8859-1 character set will be replaced by question
marks.
Cantor will use your Windows locale. Your Windows locale will affect the order
in which records are displayed in grids as well as the display of some dates, times,
and monetary values.
3. Notation
In this manual, I’ll write the names of menu items, buttons, field labels, etc.
in a slanted sans-serif font, e.g., Rating List. I’ll specify sequences of menu items,
buttons, etc. by separating them with a “>” sign. The double colon “::” means that
the sequence of items starts at the main menu. For example, you can exit Cantor
via ::Cantor > Exit. I’ll write keys on the keyboard by putting the name of the key
between angle brackets, e.g., ⟨Ctrl+Del⟩ or ⟨Enter⟩. Note that ⟨Ctrl+Del⟩ means hold
down the control key and press the delete key.

CHAPTER 2

Overview
This chapter provides a brief overview in the form of a tutorial. Working
through this tutorial is not a substitute for reading the rest of the manual.
Start Cantor. You will see the quick-start window (see Figure 1). Cantor only
displays this window if you haven’t entered any results. Close the window. You
will see Cantor’s main window (Figure 2 on the following page).
Select ::Lists > Import. You will see the window shown in Figure 3 on
the next page. Click the button at the right of the Rating list field and select
the file SampleRatingList.csv in the program folder (e.g., C:\Program Files (x86)
\RatingsCentral\Cantor). Click the button at the right of the Club list field and
select the file SampleClubList.csv in the program folder. Click the Import button.
Cantor will import the lists.
Select ::Events > Select Current. You will see the window in Figure 4 on page 19.
Click the Add Event button. The notebook will switch to the Edit page (see Figure 5
on page 20). Type “Ratings Central Open” in the Name field. Click the button at
the right of the Date field to drop down a calendar. Click the Today button. Set
State to “VA”. Click on the Change button to pop up the club browser (Figure 6
on page 20). Click the Select Club button to select the VTTA club and close the
window. Enter “1600” in the Unrated prior > Mean field, and enter “200” in the
Unrated prior > Standard deviation field (see Chapter 9 on page 67 for instructions
on how to set the Unrated prior fields for your event).
Click the Save button. You will see the Browse page and the event you just
added will be listed in the grid (see Figure 7 on page 21). Click the OK button.
The main window now displays the name and date of the event (see Figure 8 on
page 21).

Figure 1. Quick-start window
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Figure 2. Main window

Figure 3. Import-lists window

Select ::Players > Modify. You will see the window in Figure 9 on page 22. We’ll
assume the players have played in a previous event and so are on the rating list.
If you have players who have not played in a previous event, then you would add
them by clicking the Add Player button.
Since we are assuming the players are on the rating list, click the Rating List
button. You will see the rating-list browser (Figure 10 on page 22). Click the Add
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Figure 4. Select-current-event window
Player button to add David H. James to the event. You will now see the Edit page
of the modify-players notebook (Figure 11 on page 23). Click the Save button.
Click the Rating List button to bring up the rating list again. This time, click
on the line that says “O’Neill, Sean Patrick”, then click the Add Player button. Click
the Save button. The window should look like Figure 12 on page 24. Click the Close
button.
Click the New Result button at the bottom of the main window. You will see the
window in Figure 13 on page 24. Click “O’Neill, Sean Patrick” in the Winner (left)
list box and “James, David H.” in the Loser (right) list box. Enter “7”, “-4”, “10”, and
“2” in the Score boxes. The window will look like Figure 14 on page 25. Click the
OK button. Click the Cancel button to close the window. The main window will
look like Figure 15 on page 25.
The final step is to submit the event to Ratings Central. Submitting events is
covered in Section 4 on page 44 rather than in this tutorial. But, you don’t want
to submit the test event that you just created. So, click anywhere in the grid, e.g.,
click Sean’s name. The result row in the grid will now be highlighted and the words
"Ctrl+Del: Delete Result" in the bottom left will no longer be dimmed (see Figure 16
on page 26). Press ⟨Ctrl+Del⟩ to delete the result. Then select ::Events > Select
Current and press ⟨Ctrl+Del⟩ to delete the event. This also deletes the players in
the event. Select ::Cantor > Exit to close Cantor, and then use Windows Explorer to
delete the Club.nx1 and RatingList.nx1 files in the database folder. The location of
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Figure 5. Edit-event page

Figure 6. Club browser

the database folder is displayed in the status bar at the bottom of Cantor’s main
window (see Chapter 7 on page 61).

2. OVERVIEW

Figure 7. Event grid

Figure 8. Main window showing event name and date
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Figure 9. Modify-players window

Figure 10. Rating-list browser
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Figure 11. Edit-player page
Note that the sample rating list and club list files you used in this overview
are just samples—they do not contain real players or clubs. Their only purpose
is to let you work through this overview. Do not use them when running a real
event that you will submit to Ratings Central. See Section 1 on page 35 for how to
download and import real rating and club lists.
Before entering a real event into Cantor, please enter your Internet parameters
(see Section 3 on page 29) and perform the test in Section 3.3 on page 31 to make
sure you can submit events.
Before submitting a real event to Ratings Central, please read Chapter 9 on
page 67 to learn how to set the priors for unrated players.
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Figure 12. Player grid

Figure 13. New-result window

2. OVERVIEW

Figure 14. Result being entered

Figure 15. Main window showing result
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Figure 16. About to delete result

CHAPTER 3

Cantor Menu
The Cantor menu contains items that relate to the application as a whole.
1. Exit
The Exit menu item closes Cantor. No information is lost when you do this
because Cantor always writes all information to the database files immediately
after completing any operation.
2. Set Up
The Set Up menu item brings up a window (Figure 1) that lets you set your
director ID and password and the location of the list database folder.
2.1. Director. Enter your director ID in the ID field. To get a director ID, you
must register on the Ratings Central website. Your director ID is not the same as
your player ID (if you have one). If you have more than one director ID (an unusual
situation), see Section 2 on page 94.
Once you’ve submitted an event, Cantor won’t let you change the director ID.
If you submit the event using the wrong director ID, see Section 2 on page 74 for
how to fix it.

Figure 1. Set-up window
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Enter your director password in the Password field. You select your password
on the Ratings Central website. Since this is a password, Cantor will display asterisks in this field rather than the characters you type. The password is case
sensitive.
Select the sport that corresponds to your director ID in the Sport field. If you
want to submit events for more than one sport, you will need a director ID for each
sport; see Section 2 on page 94.
2.1.1. Director ID Policies. Director IDs are assigned to people, not to clubs,
organizations, or groups. This is because we need to know whom to contact if
there is a question or a problem. Each person who submits events must have
their own director ID and is responsible for the events that they submit and for
the database files for those events, including backing up the database files (see
Section 1.4 on page 14) and preserving them indefinitely in case changes to events
are needed.
Do not share your director ID with anyone else. You may have someone assist
you, but you are still responsible for the events submitted using your director ID.
You may transfer your director ID to another person by giving the other person
the database files and updating the information for the director ID on the Ratings
Central website to be that of the other person. There are a couple of ways you
can do this: One way is to change the information on the website to the other person, change the password to a temporary one, give the other person the temporary
password, and have the other person set their own password. The other way is
to change the password to a temporary one, give the other person the temporary
password, and have the other person set their own password and change the information to them. In both cases, you need to give your database files to the other
person.
Note that this system makes it simple for a club to effectively have a director
ID. All the club has to do is pick a responsible person, who registers as the director.
When that person no longer wishes to be the responsible person, the club picks a
new responsible person, and the first person transfers the director ID to the second
person.
If you are no longer able to be responsible for the events that you submitted,
do not simply disappear. It is best to find someone else to transfer your director
ID to. But, if you cannot do that, contact us; see https://www.ratingscentral.com/
Problems.php for our email address.
If you want to delete your director ID, contact us. However, we cannot delete
a director ID if there are events that were submitted using that ID. (You can search
for your events on the website by entering your director ID in the “Director ID
number” field on the “Events” tab.) If you want to delete an event, delete all the
results, then submit the event; see Section 3.1.1 on page 42. (Are you sure that you
want to delete the event? Players may wish to see their old results.) If you used
Zermelo to submit a tournament, it isn’t practical to use Zermelo to delete it. If you
need assistance deleting events, contact us. Rather than deleting events, it may be
better to transfer your director ID to another person.
2.1.2. Old Version Password Compatibility. Versions of Cantor before version
10 only accept passwords that are at most twenty ISO 8859-1 (Latin 1) characters.
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If you used such a version and you need to resubmit an event and your current
password does not satisfy the twenty ISO 8859-1 character limitation, you have
three choices: You can upgrade to the current version of Cantor, you can change
your password on the website to satisfy the limitation (and maybe change it back
when you are done), or you can enter a “short password” on the website. If you
enter a short password, it will be used with Zermelo versions before 21 and Cantor
versions before 10; your regular password will be used with other (more recent)
versions. In all cases, your regular password will be used to log in to the website.
The recommended approach is to upgrade to the current version of Cantor.
2.2. List Database Folder. The rating-list database file RatingList.nx1 and the
club database file Club.nx1 contain the same information that is in whatever rating
and club lists that you’ve imported. Since the rating-list database file can be rather
large and there is no need to back up either of the list database files, you may wish
to keep them in a folder other than the database folder, thus making it simpler to
back up the database files that you do need to back up whenever you use Cantor.
Another reason you might wish to do this is if you have more than one director
ID—see Section 2 on page 94. You can use the same list-database folder for both
Cantor and Zermelo (or two or more instances of either of them), but if you do so,
you can only have one app running at a time.
Enter the folder you wish to use in the List database folder field. Leave the
field blank to use the database folder as the list database folder. You can enter
the name of a folder that doesn’t exist and Cantor will create it. You can click the
button to the right of the field to browse to the folder you want.
If you have already imported a list, changing the list database folder will not
move the list database files. You will either have to move them yourself or import
the lists again. If you wish to move them yourself, do it when Cantor is not running.
3. Set Up Internet
The Set Up Internet menu item brings up a window (Figure 2 on the next
page) that lets you set your email and Web parameters. Cantor uses these when
submitting events to Ratings Central and when downloading rating and club lists.
Put your email address in the Your email address field. Enter only your email
address; don’t include angle brackets or a display name. If you do a test submission
(see Section 3.3 on page 31), Ratings Central will send the reply to the email address
that you enter here. If you submit an event, Ratings Central will send any error
messages to the email address that you enter here. However, Ratings Central will
send the email message that the event has been processed to the email address
that Ratings Central has for your director ID, not the email address that you enter
here. To update the email address for your director ID, log into the Ratings Central
website. We recommend that you enter the same email address here that you have
set up for your director ID.
Cantor can submit events to Ratings Central using either email or the Web.
Select the method you prefer in the Submission method drop-down list. The Web
submission method is easier to set up and will work with more Internet connections. The email submission method may work more quickly.
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Figure 2. Set-up-Internet window

3.1. Email. Enter the name of your SMTP (outgoing mail) server in the
SMTP server field. This may be something like smtp.YourDomain.com or mail.
YourDomain.com. Your Internet or email provider may include this information
on their website in their instructions for setting up your email client. If you only
use webmail, then you probably won’t find the SMTP server name in your email
settings. If you can’t find the SMTP server name anywhere, ask your Internet or
email provider.
Enter your SMTP port in the SMTP port field. The standard ports for SMTP are
25 and 587. If your Internet or email provider doesn’t tell you the port to use for
their SMTP server, try both of them (both, one, or neither may work).
Some Internet or email providers have their SMTP servers set up to use authentication (i.e., to require a username and password). If your Internet provider uses
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Figure 3. Test-sent window
SMTP authentication, check the Use authentication check box. Then enter your account username and password in the Username and Password fields. If the SMTP
server supports TLS (the “explicit” type of TLS), then check the Use TLS check box.
TLS encrypts the communication with the server so that your password is not sent
in clear text. The SMTP port to use may depend on whether you are using TLS.
When using TLS, Cantor just makes sure to create a TLS connection and does not
verify that the certificate that the server provides is really for the server, is not expired, etc. Note that just because you have a username and password doesn’t mean
that your SMTP server uses SMTP authentication. You always have a username and
password so that you can access the POP (incoming mail) server.
If you don’t have access to an SMTP server or you don’t know how to configure
Cantor to use it, then use the Web submission method.
3.2. Web Proxy Server. Usually, you don’t have to set any Web parameters.
However, some Internet connections use a proxy server to access the Web. It is
unlikely that a home connection uses a proxy server, but it is moderately common
for companies to use proxy servers. Cantor uses the Web proxy server parameters
when downloading rating and club lists and when submitting events to Ratings
Central using the Web submission method.
You can find whether you are using a proxy server by looking at your Internet options in Windows: Control Panel > Internet Options > Connections > LAN
Settings. . . > Proxy server. If the Use a proxy server for your LAN check box is
checked, then you should check Cantor’s Use proxy server check box and copy the
values from the Windows Address and Port fields to Cantor’s Server name and Port
fields. If your proxy server requires a username and password enter them in the
Username and Password fields.
Sometimes a company uses a proxy server, but you can still access the Web
even if you leave the User proxy server check box unchecked.
3.3. Test. Click the Test button to test your Internet setup. When you click this
button, Cantor will send a test submission to Ratings Central. If Cantor succeeds in
sending the test, it will display the window in Figure 3. Ratings Central will respond
with an email like the one in Figure 4 on the following page. The “Submitted” date
and time in the email will be the date and time that you clicked the Test button.
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From: Ratings Central
Sent: Saturday, March 26, 2022 1:54 PM
To: David Marcus
Subject: Ratings Central received your test
Submitted: Sat, 26 Mar 2022 13:52:16 -0400 (EDT)
Status: Test
We received the test that you sent.
Ratings Central
www.ratingscentral.com
Figure 4. Test reply email

Figure 5. Select-printer window
Usually, you will get a reply to your test in a few minutes. However, the Ratings
Central processor may be busy processing events, so it may take longer. It won’t
take more than a day.
4. Select Printer
The Select Printer menu item brings up a window (Figure 5) that lets you select
which printer Cantor prints to. If you select “Default”, then Cantor will print to
whichever printer you’ve set as the default printer in Windows. Cantor stores the
printer that you select in the Cantor.ini file, so Cantor will remember the value even
after you quit Cantor.
5. Visit Website
The Visit Website menu item opens your browser on the Ratings Central home
page (https://www.ratingscentral.com). To get to the “Event Director Support” webpage, click the “Event Director Support” link that is in the left sidebar on every page
on the website.
6. Display Version
The Display Version menu item brings up a window (Figure 6 on the facing
page) that shows version and copyright information. The version number is also
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Figure 6. Version window
shown in the title bar of Cantor’s main window. You can find the latest version of
Cantor on the Ratings Central website.
You can click on the photo to go to a webpage about Georg Cantor.

CHAPTER 4

Lists Menu
The Lists menu contains items that let you import rating or club lists and
browse the imported lists.

1. Import
The ::Lists > Import menu item brings up a window (Figure 1) that lets you
import a rating list or club list into Cantor.
You don’t need a rating list to use Cantor, but a rating list makes entering
players much simpler. Similarly, you don’t need a club list, but without one, Cantor
won’t let you enter clubs for players or events.
To add your club to the Ratings Central club list, go to the Ratings Central
website and log in (see Section 5 on page 32).
Ratings Central provides players’ personal information so that you can publicize and run your events. Please respect players’ privacy—do not use the information for other purposes or give it to anyone else.
There are two ways to download the rating and club lists: automatic and manual.

Figure 1. Import-lists window
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Figure 2. Download window

1.1. Automatic Download. To have Cantor automatically download the rating
and club lists from the Ratings Central website and import them, set the Source
drop-down list to “Web”. You won’t be able to select “Web” unless you’ve already
entered your director ID and password via ::Cantor > Set Up. You must also have
set the sport that is associated with your director ID. If you select the wrong sport,
then the import will fail with a message that Cantor can’t find a file.
If you’ve previously imported lists, then the Existing records radio box will be
active. If you select the Discard all radio button, then all the records that you
previously imported will be discarded. If you select the Keep radio button, the
new records you are about to import will be appended to the ones you previously
imported. (If you previously imported the sample rating or club lists that come
with Cantor, be sure to select Discard all.)
If you select Keep, then the For duplicates, keep. . . radio box will be active.
You have a duplicate record if there are two records for the same player ID or club
ID number. If you select New, then the new record for any duplicate will be kept
and the old one will be discarded. If you select Old, then the old record will be kept
and the new one discarded.
Click the Import button to download and import the lists. Figure 2 shows the
window that Cantor will display while downloading. Once the lists are downloaded,
Cantor will automatically import them.
In addition to importing the lists, Cantor will place text copies of the lists in
the list database folder (see Section 2.2 on page 29). The files will have names
like RatingList.csv and ClubList.csv, but if your director ID is for a sport other than
table tennis, the filenames will have a prefix that identifies the sport (i.e., “Hardbat”,
“Sandpaper”). See Section 1.2 for more information on these two files.
If you connect to the Web via a proxy server, you will need to enter your proxy
server information in ::Cantor > Set Up Internet.
1.2. Manual Download. To download a rating list and a club list manually, go
to the Ratings Central website and log in (see Section 5 on page 32). Just below
where it says “Download zipped . . . rating and club lists” (the sport name will
be where the ellipses are), click the link for the appropriate version. This will
download the two lists in a single zip archive. Save the file.
You will need any unzip program to extract the two lists from the archive.
Windows has built-in support for unzipping files. There are also dozens of unzip
programs available on the Web.
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Member ID,Last Name,First Name,Rating,State,Zip,Gender,Date of Birth,Expiration Date,Last Played Date
8840,O’Neill,Sean Patrick,2484,VA,22903,M,1/2/1967,12/31/2099,8/31/2003
56475,James,David H.,1827,VA,23227-1721,M,3/4/1973,9/30/2002,11/25/2001

Figure 3. Sample USATT rating list

Extract the contents of the zip file. You should now have two files with names
like RatingList.csv and ClubList.csv. (As mentioned above, if your director ID is for
a sport other than table tennis, the filenames will contain a prefix that identifies
the sport.) These are CSV files. “CSV” stands for comma-separated values. A CSV
file is just a text file with commas separating the values.
Excel understands CSV files, so you can open them in Excel, if you wish. You
can’t have a list open in Excel while you are trying to import it into Cantor. If
you do this, you’ll get an error message that says something like “Cannot open file
RatingList.csv: The file is open in another application.” Excel uses a nonstandard
CSV format—Cantor can import lists that are in either the standard CSV format or
in Excel’s CSV format.
Once you’ve downloaded the rating list and the club list, you are ready to
import them. Set the Source drop-down list to “File”. To import the rating-list file,
RatingList.csv, type the filename of the file in the Rating list field. Include the path
to the folder where the file is, e.g., C:\My Documents\RatingList.csv. Alternatively,
click on the button at the right of the field to browse for the file.
To import the club-list file, ClubList.csv, type the filename including path in
the Club list field, or click on the button at the right of the field to browse for the
file.
You can import both a rating list and a club list at the same time. If you do so,
then the selections you make in the radio boxes apply to both lists.
Click the Import button to import the lists.
Note that the rating list and club list are sport specific. So, if you have more
than one director ID and the director IDs are for different sports, be sure you
download and import the lists that are appropriate for your event’s sport.
1.3. USATT Rating List. Cantor can also import a USATT rating list in CSV
format that you can get from USATT. USATT provides a list that is only available
to tournament directors that includes birth dates. There may also be a publicly
accessible list that does not include birth dates. Cantor can import either version
of the list. Figure 3 shows the first few lines from such a list (including birth
dates). To compare Figure 3 to the file that you receive from USATT, view the
file in Notepad, not Excel. The first/header line must have the column headers
shown (ignoring case) and in the same order (the “Date of Birth” column can be
omitted). Each succeeding line must have the information for one player with the
fields separated by commas. Any field that contains a comma must be surrounded
by double quotes. The “State” column may contain a three-letter country code.
Unrated players must have a rating of “0” or blank. Dates must be in m/d/yyyy
format. Gender must be either “M”, “F”, or blank. Players with life memberships
must have an expiration date of “12/31/2099”.
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Figure 4. Import-lists error window
Import the USATT rating-list file the same way that you would import the Ratings Central RatingList.csv file, i.e., set the Rating list field to the name and path of
the file and click the Import button.
You can import both a Ratings Central rating list and a USATT rating list. When
you import the second rating list, you will need to select the Keep radio button in
the Existing records radio box. For the For duplicates, keep. . . radio box, it doesn’t
matter whether you select New or Old because Cantor knows to not confuse player
IDs from the two organizations.
1.4. Import Errors. If Cantor encounters a problem parsing a line in a list that
it is importing, it will display a window with a message explaining what the problem
is and what line is causing the problem; see Figure 4. Click the Continue Importing
button to skip the line and continue importing the list. Click the Continue and
Ignore Errors button to skip the line, continue importing, and silently skip any
subsequent lines that have errors. Click the Stop Importing button to stop importing the list. In all cases, any lines already imported will remain imported and the
problem line will not be imported.
2. Browse Rating
The Browse Rating menu item brings up a window that lets you browse the
rating lists that you’ve imported. See Section 1.3 on page 55 for more information.
3. Browse Club
The Browse Club menu item brings up a window that lets you browse the club
list that you’ve imported. See Chapter 8 on page 65 for more information.

CHAPTER 5

Events Menu
The Events menu contains items that let you set the current event, add events,
set event parameters, and submit events to Ratings Central.
Ratings Central identifies an event by its date and director ID. So, Cantor only
allows you to have one event on a given date. If you need to submit two events on
the same date, see Section 2 on page 94 for instructions on how to do this.
Do not use the same director ID with Zermelo, or any other client, to submit
an event on the same date as an event that you are submitting with Cantor. Do not
use the same director ID with two sets of Cantor database files, since then there
will be nothing to prevent you using the same event date in both sets, and you
must not do that.
If you accidentally submit two different events using the same date and director ID, you must completely delete the event from Ratings Central (by submitting
the event with no results), then resubmit the event that you want to have this date
and director ID. If you do not completely delete the event, new players in the event
may have the wrong names, ratings, etc. If you need help with this, please contact
us; see https://www.ratingscentral.com/Problems.php for our email address.

1. Multiple-Day Events
While events are identified by their date, you don’t have to have all the matches
be played on a single day. For example, if you run a tournament that lasts two or
three days, you should put all the matches into a single event. If you play matches
at your club several nights during the week, you could treat each day’s matches as
a different event, but it would probably be better to consider the week’s matches
to be a single event. If you run a weekly league that has a season spanning several
months, you could consider each week to be an event or you could consider several
weeks or the whole season to be an event.
Ratings Central will calculate different ratings depending on how you group
the matches into events. Bunching up matches into fewer events will generally
improve the accuracy of the ratings, since the system has more information on
how each opponent is playing and because information only flows forward in time
in the rating system. In particular, if you have a large number of unrated players
in your league, it would probably be better to bunch up more matches into a single
event. Bunching up matches changes how the temporal update is applied, since the
system treats all the matches as being played on the same date. So, all the matches
in a single event should be from a reasonably short span of time. A few weeks is
reasonable. Three our four months is probably the longest that is reasonable.
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This flexibility in what constitutes an event is mainly for leagues. In general,
each tournament should be its own event and not combined with other tournaments. Note that the Ratings Central website displays all the matches in an event
together and as occurring on a single date. So, if you need to track how players
improve during your league season, you may not want to treat the whole season
as a single event. If you aren’t sure what to do, please contact us for advice; see
https://www.ratingscentral.com/Problems.php for our email address.
Normally, the event date is the first day of the event. However, this isn’t required. If you prefer, you can use the last day or a day in the middle. This choice
will affect the ratings, but the effect will not be large.
If your event lasts more than one day, you could submit the event each day.
This is rarely worth the effort for a tournament. But, if you are combining multiple
weeks into one event for a league, you might wish to resubmit the event each
week. When you resubmit the event, Ratings Central will recalculate the ratings
taking into account all the matches in the event. Note that Ratings Central will not
let you submit an event before the event date. Also note that Ratings Central will
only send one email to a player for a given event notifying them that the event has
been posted on the website. So, if you resubmit an event, players who were in the
first submission will not receive a second email. If you think it would be useful for
there to be a way to request that players be notified again, let us know.

2. Subevents
Tournaments typically are composed of several “events”, e.g., singles, doubles,
team, open, junior, senior, rating-limited. In this manual and for Ratings Central,
the word “event” never refers to this type of event. In this manual, if we need to
refer to this type of event, we will say “subevent”. For Ratings Central, an event is
a collection of matches that are submitted together. A tournament should always
be submitted as a single Ratings Central event. An exception to this rule is if
the players can be separated into groups such that the groups don’t play each
other. For example, if males only play males and females only play females, then
submitting the male matches as one event and the female matches as another event
will not change the ratings and may make the event summary report and detailed
report webpages on the Ratings Central website easier to peruse.
One of the requirements for submitting an event or tournament to Ratings
Central is that you submit all matches that are part of the event or tournament, not
just some of them. In particular, don’t just submit the matches played by your club
members (for example). However, if you wish to run an unrated novice subevent
or some sort of “fun” subevent as part of your tournament, it is acceptable to
submit the tournament and not submit the novice or “fun” subevent. Note that
you should never submit a handicap subevent (i.e., a subevent where the weaker
player is spotted points) for ratings.

3. Select Current
The Select Current menu item brings up a tabbed-notebook window (Figure 1
on the next page) that lets you select which event is the current event. The current
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Figure 1. Select-current-event window
event is displayed in Cantor’s main window and is the event that you can add
players and results to.
The Select Current menu item also lets you browse and add events and set the
parameters for each event.
3.1. Browse. The first page of the notebook (the Browse page) contains a grid
listing the events along with various parameters for each event. Just like Cantor’s
other grids, you can resize a column by dragging an edge of the column header,
you can rearrange the order of the columns by dragging a column header with
the mouse, and you can sort the grid on a column by clicking the button to the
right in the column header. You can only sort the grid on columns that have the
button. The column that is being used for sorting will show a downward-pointing
arrowhead in the button.
The grid lets you select which event is the current event. The current event is
indicated by the right-pointing arrowhead in the leftmost column of the grid. If the
grid has the focus (see Section 4 on page 84 for an explanation of “focus”), then
the current event is also highlighted. When you click the OK button to close the
window, Cantor will update the main window so it displays the name, date, and
results of the current event. If you click the Cancel button, then Cantor will not
change which event was current. You can also double-click the row of an event to
select it as the current event and close the window.
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Figure 2. Edit-event page
The columns of the event grid display information that you can also view on
the Edit notebook page. Each column is described below when we describe the Edit
page.
The Add Event button switches to the Edit page to let you add a new event.
The Edit Event button switches to the Edit page for the currently selected event;
you can also click the Edit notebook tab.
3.1.1. Delete Event. Press ⟨Ctrl+Del⟩ to delete the event that is highlighted. The
grid must have the focus for you to delete an event. Cantor will not let you delete an
event if there are any match results entered for the event or if you have submitted
the event and made any modifications to the event since you’ve submitted it. If you
want to delete such an event, first delete all the results. If you haven’t previously
submitted the event, you will now be able to delete it. If you have previously
submitted the event, then resubmit it. To make sure that the resubmission worked,
wait until you get the email confirmation that the event is deleted, or check the
Ratings Central website and make sure that the event is no longer there. Then,
delete the event. You can tell whether you can delete the highlighted event by
whether the words “Ctrl+Del: Delete Event” just below the grid are dimmed or not.
3.2. Edit. Figure 2 shows the Edit notebook page.
3.2.1. Navigation and Saving. Any changes you make on the Edit notebook
page are not saved to the database files until you save them. One way to save your

3. SELECT CURRENT

43

changes is to click the Save button. If you click the Browse notebook tab, Cantor
will save your changes just as if you clicked the Save button.
In the bottom left of the window there is a navigator bar with four buttons.
This lets you move to a different event without first going back to the Browse page.
The left navigator button moves to the first event (order of events is determined by
how the grid on the Browse page is sorted), while the right navigator button moves
to the last event. The middle-left button moves to the event before the one that
is displayed, while the middle-right button moves to the event after the displayed
one. If you navigate to a different event, Cantor first saves any changes you have
made to the displayed event. If you do not want to save your changes, you should
click the Cancel button instead.
3.2.2. Name. Enter the name of the event in the Name field. You must set the
name for the event.
3.2.3. Date. Enter the date of the event in the Date field. If the event lasts more
than one day, see Section 1 on page 39.
Although the field displays the date using the month name, you can enter the
date using numbers. If you do use numbers, they must be in the order month-dayyear. Generally, Cantor uses your Windows regional settings to display dates in
the format that is appropriate for your region, but because this field displays the
month name, you must enter the month number first. You can also set the date by
clicking the button to the right of the field to drop down a calendar.
Once you’ve submitted the event, you can’t change the date in Cantor. If you
submit the event using the wrong date, see Section 2 on page 74 for how to fix it.
3.2.4. Match Format. When you enter results, you can select the match format
for each result. Since it would be tedious to have to change the format for every
result, the Match format field lets you set the default format to use when entering
results for matches in the event. In other words, this field lets you set which
match format the New Result window starts out with when you click the New Result
button. See Section 1 on page 62 for more information.
3.2.5. State and Province. For the USA and Canada, set the State field to the
state (for the USA) or province (for Canada) where the event is located. For countries other than the USA and Canada, set the Province field to the province where
the event is located; you may leave the Province field blank. The State and Province
fields will be enabled or disabled appropriately when you select the country. Cantor also uses the event state and province as the default state and province when
adding new players to the event. When you add a new event, Cantor initializes the
state and province to the state and province of the current event.
3.2.6. Country. Set the Country field to the country where the event is located.
Cantor also uses the country as the default country when adding new players to
the event. When you add a new event, Cantor initializes the country to the country
of the current event.
3.2.7. Club. The Club box shows the club that is sponsoring the event. An
event does not have to have a sponsoring club. When you add a new event, Cantor
initializes the club to the club of the current event.
Cantor won’t let you type the name of a club in the club field. To set or change
the club, click on the Change button to bring up the club browser. The club browser
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Figure 3. Submit-events window
is described in Chapter 8 on page 65. The Change button will only be enabled if
you have imported a club list (see Section 1 on page 35). To clear the club, click
the Clear button.
3.2.8. Unrated Prior. The Mean and Standard deviation fields let you specify
the mean and standard deviation of the playing strength of unrated players in the
event. You must set both of these. See Chapter 9 on page 67 for advice on what to
put in these fields.
3.2.9. Status. The Modified check box indicates whether you’ve made any modifications to the event, its players, or its results that require that the event be submitted or resubmitted. This is an informational check box, i.e., you can’t change it.
If the Modified check box is checked, then Cantor will submit this event the next
time you submit events.
The Submitted check box indicates whether the event has ever been submitted.
This is also an informational check box.
The Submit failed check box lets you tell Cantor that the previous submission
of the event didn’t work, i.e., wasn’t received by Ratings Central. If you check this
box, then Cantor will resubmit the event the next time that you submit events. You
will need to re-check any player New personal info check boxes that were checked
in the prior submission. See Section 1.2.12 on page 53 for more information on the
New personal info check box.
For more information on submitting events, see Section 4 and Chapter 10 on
page 71.
4. Submit
The Submit menu item brings up a window (Figure 3) that lets you submit
events to Ratings Central.
4.1. Submit Events. Click the Submit Events button to submit results to Ratings Central. Clicking this button submits all events to Ratings Central that need
to be submitted. You do not have to, nor can you, specify a single event to submit.
The button will be disabled unless there are events to submit. The button will
also be disabled if you haven’t entered your director ID and password (in ::Cantor >
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Figure 4. Import-events window
Set Up) or haven’t set up your Internet parameters (in ::Cantor > Set Up Internet).
If the button is disabled for a reason other than there being no events to submit,
a message will be displayed below the button giving the reason that the button is
disabled.
If an event has not been submitted before, then it will be submitted if it has any
results. Once an event has been submitted, it will be resubmitted if you’ve made
any changes to the event, its players, or its results that Ratings Central needs to
know about.
You can tell if an event will be submitted by looking at the grid in ::Events >
Select Current. Cantor will submit the event if the row for the event says “Modified”
or “Submit Failed”. You can also look on the Edit page of the notebook to see if
either the Modified check box or the Submit failed check box is checked.
See Chapter 10 on page 71 for what happens when you submit events.
4.1.1. Correcting Errors. If you need to correct any of the match results, player
data, or other information that you submitted, just correct them and then click the
Submit Events button to submit the events again. If you are correcting a player’s
personal information, you will have to check the player’s New personal info check
box. Do not check the New personal info check box if you are only correcting
a player’s ID, rating, or unrated prior. See Section 1.2.12 on page 53 for more
information on the New personal info check box. See Section 1 on page 72 for how
to fix a duplicate player. See Section 2 on page 74 for how to fix the event date or
director ID after the event has been submitted.
If a player or another event director contacts you to inform you of an error
that you need to correct, you should reply to them within one business day and fix
the problem within one week.
4.2. Previous Submissions. The grid at the bottom of the window shows each
submission of an event. The grid works like Cantor’s other grids (see Section 9 on
page 87). The “Submitted” column is the date and time that Cantor sent the event
to Ratings Central.
5. Import
The ::Events > Import menu item brings up a window (Figure 4) that lets you
import event report files into Cantor. The event report files will either have been
constructed by you (using the API documentation that you got when you requested
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the documentation from Ratings Central) or will have been given to you by Ratings
Central (because the database files that were used to generate the event reports and
submit the events to Ratings Central have been lost; see Section 3 on page 74). The
menu item will be disabled if you haven’t entered your director ID (in ::Cantor >
Set Up).
Type the name of the folder that contains the event report files in the Folder
field. Include the path to the folder. Alternatively, click on the button at the right
of the field to browse for the folder.
Leave the Processed check box checked if the events have already been processed by Ratings Central. If they have not been processed, uncheck the check
box.
Click the Import button to import the event reports. Cantor will import all the
event report files in the folder that are for your director ID, i.e., all the files of the
form YYYY-MM-DD_<ID>.dat where <ID> is your director ID. Before importing the
events, Cantor will read all of the files to make sure that there are no problems. If
it finds a problem, it will display a message and not import any of the events. If
there are no problems, it will import all the events. So, it should either import all
the events or none. After importing the events, it will display a message that says
how many events it imported.
If the event report files that you want to import are for a different director ID
than your other events, see Section 2 on page 94.
Since Cantor requires that player names in an event be unique (see Section 1.2.1
on page 50), if two players in an event report file have the same name, Cantor will
append the player’s report ID to one of the names. The report ID is the ID in the
event report file that identifies the player. This will either be the player’s Ratings
Central ID or a negative number. A negative report ID is a temporary ID that is
used because the player did not have a Ratings Central ID when the event was
submitted.
If a player’s report ID is negative and the event has been processed, you won’t
be able to delete the player even if you delete all of the player’s results. This is so
that Cantor will know that the particular temporary ID has been used and not use
it for a different player that you subsequently add to the event. After resubmitting
such an event, you also won’t be able to delete any players without Ratings Central
IDs that you added to the event after importing it (since they will now have been
assigned temporary IDs). This shouldn’t cause a problem since you can delete
any erroneous match results that involve such players, even if you can’t delete the
players from the event in Cantor.
If you check the Processed check box, Cantor will add the events to the Previous
Submissions log just as if Cantor had originally submitted them.
Cantor will ignore the value of the New personal info flag in the event report
file unless the player has a Ratings Central ID and you do not check the Processed
check box. The reason for this is the following: If you check the Processed check
box, then the value of the flag in the file was used when the event was processed, so
is not relevant for any resubmission. If you do not check the Processed check box
and the player does not have a Ratings Central ID, then the player will be created
when the event is submitted, so the flag is meaningless.
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5.1. Ratings Central API. As mentioned above, there is an API that lets you
construct an event report and submit it to Ratings Central without using Cantor
or Zermelo. If you need the documentation for the API, contact us; see https:
//www.ratingscentral.com/Problems.php for our email address.
While the API documentation explains how to submit an event report without
using Cantor, you could also construct the event report according to the API documentation, then import the event report file into Cantor and have Cantor submit
it. If you do this, any corrections that you need to make to the event after it has
been submitted must be made in Cantor. In other words, you must have only one
master copy of an event. Once you import it into Cantor, then the master copy is
the one Cantor has, not the file that you imported. There is no “replace” option
on the import to replace an event that is already in Cantor nor is there any way to
export an event from Cantor.
You could also use Cantor to check your event report files for errors without
using Cantor to submit them: Start Cantor on an empty database folder (see Appendix D on page 93). Import your event report files into Cantor. See if Cantor
reports any errors. Exit Cantor. Delete the files in the database folder.
Cantor will use the temporary IDs in the event report file that you import when
submitting the event to Ratings Central, even if the event has not been submitted
before. This allows you to use temporary IDs that are meaningful to you.
Never submit test data to Ratings Central.

CHAPTER 6

Players Menu
The Players menu contains items that let you add players to, modify players
in, and print lists of the players in the current event. The current event is the one
that is displayed in the main window and which you selected via ::Events > Select
Current.
1. Modify
The Modify menu item brings up a tabbed-notebook window (Figure 1) that lets
you add and modify players in the current event and access the rating list. This
menu item will be disabled until you have selected a current event.
1.1. Browse. The first page of the notebook (the Browse page) contains a grid
listing the players along with various information about each player. The grid

Figure 1. Modify-players window
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works like Cantor’s other grids (see Section 9 on page 87). The columns of the
player grid display information that you can also view on the Edit notebook page.
Each column is described below when we describe the Edit page.
The Find field lets you search for a specific player. This is an incrementalsearch field, so you can type just the first part of what you are searching for and
the grid will move to the first matching player. The search happens after every
keystroke. The value you type must be the sort of thing that is in the column that
the grid is sorted on, e.g., if you want to search for a player by name, you must sort
the grid by name by clicking on the button in the header of the “Name” column.
The Add Player button switches to the Edit page to let you add a new player
to the event. The Edit button switches to the Edit page for the currently selected
player; you can also click the Edit notebook tab or double-click the player’s row.
The Close button closes the window.
Press ⟨Ctrl+Del⟩ to delete the player that is highlighted. The grid must have
the focus for you to delete a player. Cantor will not let you delete a player who
has any results. (To delete the player, first delete the player’s results.) You can
tell whether you can delete the highlighted player by whether the words “Ctrl+Del:
Delete Player” just below the grid are dimmed or not. If you imported the event,
Cantor may not let you delete the player even if they do not have any results; see
Section 5 on page 45.
The Rating List button brings up the rating-list browser. See Section 1.3 on
page 55 for more information on the rating-list browser.
1.2. Edit. Figure 2 on the facing page shows the Edit notebook page. This
notebook page handles navigation and saving just as the ::Events > Select Current >
Edit notebook page (see Section 3.2.1 on page 42).
1.2.1. Name. Enter the player’s name in the Name field with the surname first,
then a comma, then the given names. If the player’s name has a suffix, e.g., “Jr.”,
add that after a comma at the end. Since Cantor identifies players by their name,
you cannot have two players in an event that have exactly the same name.
The button to the right of the Name field brings up the rating-list browser
positioned on the player in the rating list whose name is closest to the name you
have in the Name field. The button will be disabled unless you’ve imported a rating
list. The shortcut key for the button is ⟨Ctrl+N⟩. This shortcut key also works from
the Browse page of the notebook. See Section 1.3 on page 55 for more information
on the rating-list browser.
Never do the following sequence of actions:
(1) Add a player leaving the IDs > Ratings Central field blank.
(2) Submit the event.
(3) Change the player’s name in the Name field to that of a different player
while leaving the IDs > Ratings Central field blank and without checking
the New personal info check box.
(4) Resubmit the event.
If you aren’t sure why you should not do this, see Section 1.2.12 on page 53 for
more information on the New personal info check box, and see the discussion of
how Cantor and Ratings Central keep track of players without a Ratings Central
ID in Chapter 10 on page 71. If despite this warning you think that you need to
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Figure 2. Edit-player page
do this, contact us to discuss it; see https://www.ratingscentral.com/Problems.php
for our email address.
1.2.2. IDs. Enter the player’s Ratings Central ID number in the Ratings Central
field. If the player does not have a Ratings Central ID (because this is the first time
that the player has played), then leave the field blank.
The button to the right of the Ratings Central field brings up the rating-list
browser positioned on the player whose Ratings Central ID is closest to the value
in the Ratings Central field. The button will be disabled unless you’ve imported a
Ratings Central rating list. The shortcut key for the button is ⟨Ctrl+R⟩.
Enter the player’s USATT ID number in the USATT field. If the player does not
have a USATT ID, then leave the field blank. Ratings Central will save the USATT ID
in its database to help identify the player, but does not use the USATT ID for any
other purpose.
The button to the right of the USATT field brings up the rating-list browser
positioned on the player whose USATT ID is closest to the value in the USATT field.
The button will be disabled unless you’ve imported a rating list. The shortcut key
for the button is ⟨Ctrl+U⟩.
Enter the player’s TT Australia ID number in the TT Australia field. If the player
does not have a TT Australia ID, then leave the field blank. Ratings Central will save
the TT Australia ID in its database to help identify the player, but does not use the
TT Australia ID for any other purpose.
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The button to the right of the TT Australia field brings up the rating-list
browser positioned on the player whose TT Australia ID is closest to the value
in the TT Australia field. The button will be disabled unless you’ve imported a
Ratings Central rating list. The shortcut key for the button is ⟨Ctrl+T⟩.
Enter the player’s ITTF ID number in the ITTF field. If the player does not
have an ITTF ID, then leave the field blank. If the player has played in an ITTF
tournament, Ratings Central may have the ITTF ID for the player in its database
(and in the rating list that you download). However, you cannot set or modify the
ITTF ID for a player in the Ratings Central database. If the player has an ITTF ID
in the Ratings Central database, then the effect of checking the New personal info
check box is different; see Section 1.2.13 on page 54 for more information.
The button to the right of the ITTF field brings up the rating-list browser positioned on the player whose ITTF ID is closest to the value in the ITTF field. The
button will be disabled unless you’ve imported a Ratings Central rating list. The
shortcut key for the button is ⟨Ctrl+I⟩.
See Section 1.3 on page 55 for more information on the rating-list browser.
The shortcut keys for the rating-list-browser buttons also work from the Browse
page of the notebook.
1.2.3. Address. Enter the player’s address in the Address 1 and Address 2
fields. If you only need one line for the player’s address, leave the Address 2
field blank. The address is optional, but helps directors identify the player.
1.2.4. City. Enter the player’s city in the City field. The city is optional, but
helps directors identify the player.
1.2.5. State and Province. For the USA and Canada, set the State field to the
state (for the USA) or province (for Canada) that the player is from. For countries
other than the USA or Canada, if the player’s mailing address includes a province,
enter it in the Province field. The province is optional, but helps to identify the
player. The State and Province fields will be enabled or disabled appropriately
when you select the country. When you add a new player, Cantor initializes the
state and province to the state and province of the event, since most new players
are from the state that the event is in.
1.2.6. Postal Code. Enter the player’s postal code in the Postal code field. The
postal code is optional, but helps to identify the player.
1.2.7. Country. Set the Country field to the country that the player is from.
When you add a new player, Cantor initializes the country to the country of the
event, since most new players are from the country that the event is in.
1.2.8. Email. Enter the player’s email address in the Email field. Enter only the
email address; don’t include angle brackets or a display name. The email address
is optional.
When you submit an event, Ratings Central will send an email to each player
who played in the event to let them know that the event has been posted. The
email will contain a link to the results on the Ratings Central website and a link
so that the player can unsubscribe from receiving future emails. Of course, the
player will only receive the email if Ratings Central has the player’s email address.
At most one email will be sent to a player for a given event. So, if you resubmit an

1. MODIFY

53

event (e.g., to make corrections), players who were in the first submission will not
receive a second email.
1.2.9. Sex. Set the Sex field to the player’s sex.
1.2.10. Birth. Enter the player’s birth date in the Birth field. Use the yearmonth-day order that matches your Windows regional settings. The birth date
is optional, but helps to identify the player.
If a player in the Ratings Central rating list that you download has an ITTF ID,
then the birth date probably came from the ITTF website. But, the ITTF website
only has birth years. So, lacking any other information, Ratings Central set the day
to January 1. If you know the correct day, you may correct the birth date, if you
wish.
1.2.11. Deceased. Check the Deceased check box if the player is deceased (i.e.,
dead, no longer living). Obviously a deceased player cannot be playing table tennis.
However, it would be appropriate to check this box if you are correcting an event
that you submitted in the past or entering the results of an event from the past
and the player has died since they played the event.
1.2.12. New Personal Info. Check the New personal info check box if the personal information that Ratings Central has for the player is incorrect or incomplete
and you are updating it.
The New personal info check box only applies to the personal information
fields, i.e., the Name, IDs > USATT , IDs > TT Australia, Address 1, Address 2, City,
State, Province, Postal code, Country, Email, Sex, Birth, Deceased, and Club fields. If
you check the New personal info check box, the values in all these fields will be sent
to Ratings Central and will replace the corresponding information for the player
that Ratings Central has (however, if the player has an ITTF ID, see Section 1.2.13
on the next page). Note that this includes any fields that you clear. For example,
if you clear a player’s Email field and check the New personal info check box, then
after you’ve submitted the event, Ratings Central will not have an email for the
player. Also note that if you check the New personal info check box, you should
make sure that all of the personal information fields for the player have the correct
information since all of them will be sent to Ratings Central.
Do not check the New personal info check box if you only make changes to
the Rating, Standard deviation, or Unrated prior fields, since the check box has
nothing to do with these fields.
Generally, you should not check the New personal info check box if you change
the IDs > Ratings Central field. (The most common reason you would change the
IDs > Ratings Central field is if a player has two Ratings Central IDs, an original
one and a duplicate, and you are changing the value in the field to the player’s
original ID.) The Ratings Central ID is not personal information about the player,
but rather identifies who the player is. If you change the IDs > Ratings Central field
and also check the New personal info check box, then this means that you want
Ratings Central to update the personal info for the player who corresponds to the
new ID. This is unlikely to be what you want.
See Chapter 10 on page 71 for more information.
The New personal info check box will be disabled if the player’s IDs > Ratings
Central field is blank and the event has not been submitted (since there is no old
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info in this case to update). When you submit the event, Cantor will clear the New
personal info check box (since the new info has now been sent to Ratings Central).
Note that Cantor only submits a player to Ratings Central if the player has
played at least one match. So, checking the New personal info check box will have
no effect if the player doesn’t play any matches in the event.
1.2.13. ITTF IDs and Personal Info. If a player has an ITTF ID in the Ratings
Central database, then you cannot change the player’s name, country, sex, or birth
year. So, checking the New personal info check box will only affect the other parts
of the player’s personal information. Also, you can’t set or modify the ITTF ID. And,
your updates to the player’s address will only be accepted if you set the country to
the country that the player already has (since you can’t change the country and an
address in a different country wouldn’t make sense). The Ratings Central website
enforces the same restrictions. If you think the personal information that you can’t
change should be changed for some player, contact us.
1.2.14. Rating. Enter the player’s rating in the Rating field. If the player is unrated, leave the field blank or enter an estimated rating. This field is not submitted
to Ratings Central when you submit the event. It is only for your information. It
is displayed in the player grid (on the Browse page of the notebook) and the result
grid (in the main window) and printed on the player and result lists (when you do
::Players > Print or click the Print Results button in the main window).
Note that the Ratings Central and USATT rating scales are different. See Chapter 9 on page 67 for more information.
1.2.15. Standard Deviation. Enter the player’s standard deviation in the Standard deviation field. If the player is unrated, leave the field blank or enter an
estimated standard deviation. This field is not submitted to Ratings Central when
you submit the event. It is only for your information. It is displayed in the player
and result grids and printed on the player and result lists.
1.2.16. Unrated Prior. The Mean and Standard deviation fields in the Unrated
prior box let you specify the mean and standard deviation of the playing strength
of the player, if this is the player’s first event. You can leave these fields blank, but
if you set one, you must set both. See Chapter 9 on page 67 for advice on what to
put in these fields.
1.2.17. Club. The Club box shows the club that the player is from. A player
can be from more than one club, but Cantor only lets you set one club for a player.
The club you set for the player in Cantor will be the player’s primary club. To
add a secondary club for the player, you must go to the Ratings Central website
and log in (see Section 5 on page 32). A player doesn’t have to belong to a club.
If you change an existing player’s primary club (and check the New personal info
check box), the player will still be a secondary member of the old primary club. To
remove the player completely from the club, you must go to the Ratings Central
website and log in.
You set or change the player’s club just as you do for the event club on the
::Events > Select Current > Edit notebook page (see Section 3.2.7 on page 43). If the
player’s club is not set, then when you click the Change button, the club browser
will come up with the event club selected. Since most new players are from the
club that is sponsoring the event, this makes it easy to set these players’ clubs.
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Figure 3. Rating-list browser

1.3. Rating-List Browser. The rating-list browser (Figure 3) lets you view the
rating list. You can bring up the rating-list browser from either page of the player
notebook or from the ::Lists > Rating menu item. From the Browse page of the
player notebook you can click the Rating List button. From the Edit page, you
can click any of the buttons that show a hand pointing to a list of records. From
either page, you can use the ⟨Ctrl+N⟩, ⟨Ctrl+R⟩, ⟨Ctrl+U⟩, and ⟨Ctrl+T⟩ shortcut
keys. These bring up the rating-list browser on the player whose name, Ratings
Central ID, USATT ID, or TT Australia ID (respectively) is closest to that of the
player that you are editing or that you have selected in the grid on the Edit page.
A button and shortcut will be inactive unless you’ve imported a suitable rating list
via ::Lists > Import.
The rating-list grid works like Cantor’s other grids (see Section 9 on page 87).
The meaning of most of the columns should be obvious. The “Last Played” column
contains the date of the last event that the player played. The “Source” column
indicates whether the record came from Ratings Central (“R.C.”) or USATT. The
“Expiration” column contains the player’s USATT membership expiration date. If
the player has a life membership, the “Expiration” column will say, “Never”.
The Find field lets you search for a specific player. It works like Cantor’s other
incremental-search fields (see Section 9.1 on page 87).
Click the Add Player button to close the rating-list browser and add the selected player to the current event. If you were editing a player (i.e., you were on
the Edit page of the player notebook), Cantor will save any changes you made to
the player. Then Cantor will add a new player to the current event and copy the
information for the player you selected in the rating-list browser from the rating
list to the new-player’s fields, all ready for you to save the player.
Click the Overwrite Player button to close the rating-list browser and overwrite
the player that you were editing or had selected in the player grid with the player
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Figure 4. Copy-players-from-event window
you selected in the rating-list browser. This copies all values from the player in
the rating list to the player that you were editing or had selected, including blank
values.
Click the Merge Player button to close the rating-list browser and merge the
information from the player that you selected in the rating-list browser into the
player that you were editing or had selected in the player grid. This copies all nonblank values from the player in the rating list to the player that you were editing or
had selected. But, if a value for the player in the rating-list browser is blank, then
the corresponding value for the player that you were editing or had selected will
be retained; it will not be blanked.
Click the New Player button to close the rating-list browser and add a new,
blank player to the current event. If you were editing a player, Cantor will save
any changes you made to the player. If the rating-list grid is sorted on the “Name”
column, Cantor will set the new-player’s name to the contents of the Find field. If
the string in the Find field is all lower case, Cantor will capitalize the initial letters
of words when setting the new-player’s name. This makes it easy to add a player
when you discover that the player you are looking for is not in the rating list.
Click the Close button to close the rating-list browser without changing the
players in the event.
If you open the rating-list browser from the Rating List button on the Browse
page, the Overwrite Player and Merge Player buttons will be disabled, the Add
Player button will be the default button, and you can double-click a player in the
grid to add the player to the current event.
If you open the rating-list browser from the ::Lists > Browse Rating menu item,
the Add Player, Overwrite Player, Merge Player, and New Player buttons will be
disabled.
If the list database folder is set (see Section 2.2 on page 29), the title bar of the
window shows the folder’s location.
2. Copy from Event
The Copy from Event menu item brings up a window (Figure 4) that lets you
copy players from another event into the current event. This is a convenient way
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Figure 5. Import-players window

to add players to the current event if another event has many players in common
with the current event. The menu item will be disabled if you don’t have at least
two events.
Select the other event in the grid. Then click the OK button. Cantor will copy
the players from the selected event to the current event. Cantor will only copy
players that have Ratings Central ID numbers. Cantor will not copy a player if the
player’s name or player’s Ratings Central, USATT, or TT Australia ID number is the
same as that of a player who is already in the current event.
You can also double click the event in the grid. This will select the event and
immediately copy the players.
If you check the Update info from rating list check box, then Cantor will replace
each copied player’s information (i.e., name, address, rating, etc.) with the player’s
information from the rating list.
Note that if you create an event and add players to it, but never add any results
to it, then Cantor will never submit it. So, for example, you could create a dummy
event containing the members of your club and copy the players from this dummy
event to each new event that your club runs.

3. Import
The ::Players > Import menu item brings up a window (Figure 5) that lets you
import players from the rating list into the current event. The menu item will be
disabled until you have selected a current event and have imported a rating list.
You specify the players to import by providing a text file containing IDs. The
file must have each ID on its own line. Blank lines are ignored, as are leading and
trailing spaces and tabs.
You can construct this file in many ways. Possibilities include the following:
You could keep or create a list of players in Excel or Microsoft Access, then write
the IDs to a file (e.g., Save As Text) or copy them into a text editor such as Notepad.
You could open the Ratings Central rating list in Excel, sort and filter it to make
it more manageable, mark the players who are coming to your event, sort them to
the top or filter to select just them, then copy the IDs to Notepad. You could copy
a list of players from a page on the Ratings Central website, then edit the list to
contain the IDs that you want.
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Set the Organization drop-down list to the organization that assigned the IDs.
If you have imported a Ratings Central rating list, then you can use IDs from Ratings Central, USATT, TT Australia, or ITTF. Note that it is up to event directors to
enter the USATT and TT Australia IDs into the Ratings Central database, so these
values may be missing for some players on the Ratings Central rating list. If the
only rating list that you have imported is from USATT, then you can only use IDs
from USATT, since these are the only IDs that the USATT rating list has.
Type the filename of the file of IDs in the ID list field. Include the path to the
folder where the file is. Alternatively, click on the button at the right of the field to
browse for the file.
Click the Import button to import the players. If any players cannot be imported, Cantor will display a window listing the IDs that could not be imported
and the reason. The possible reasons are
Bad value for ID. The ID value is not an integer or not in the correct range.
Already a player in event with ID.
ID not found on rating list.
More than one player on rating list with ID. So, it isn’t clear which player
should be imported.
• ID from a different organization conflicts with a player in event. The
player was found on the rating list, but the record for the player in the
rating list includes an ID from a different organization that is the same as
a player already in the current event.
•
• Already a player in event with same name. Since Cantor identifies players
by their name, you cannot have two players in an event that have exactly
the same name.
•
•
•
•

If you have imported rating lists from both USATT and Ratings Central and
are importing players by specifying USATT IDs, then Cantor will first look for the
player on the Ratings Central list, and import that record, if there is one. If there
isn’t one, then it will look for the player on the USATT list.
If the state or country on the rating list are not valid, Cantor will use the state
and country values for the current event.
If the gender value on a USATT rating list record is missing, Cantor will use
male.
4. Print
The Print menu item brings up a window (Figure 6 on the next page) that lets
you print lists of the players in the current event.
If you check the Name check box, Cantor will print a player list sorted alphabetically (see Figure 7 on the facing page). If you check the Rating check box, Cantor
will print a player list sorted in order of rating (see Figure 8 on the next page). The
latter list also shows the seeding of each player in the event.
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Figure 6. Print-lists window

Figure 7. Player list sorted by name

Figure 8. Player list sorted by rating
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CHAPTER 7

Main Window
Figure 1 shows Cantor’s main window. The main menu is at the top. Below
that is the name and date of the current event. Below that is a grid showing all the
match results for the current event. The grid works like Cantor’s other grids (see
Section 9 on page 87).
The event date is displayed using long date format specified in your Windows
regional settings. You can change these settings in Control Panel > Regional and
Language Options.
Press ⟨Ctrl+Del⟩ to delete the result that is highlighted. The grid must have the
focus for you to delete a result.
The “#” column shows the order in which you entered the results. So, result
#1 is the first result that you entered for the event, result #2 is the second, etc.
Deleting a result does not change the numbers of the other results.
The status bar at the bottom of the window shows the location of the database
folder.

Figure 1. Main window
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Figure 2. Result window
1. New Result
The New Result button brings up a window (Figure 2) that lets you enter results
for the current event. The button will be disabled until you’ve added at least two
players to the current event.
Select the winner in the Winner (left) list box and select the loser in the Loser
(right) list box. In addition to using the mouse or cursor keys, you can also type
the player’s name. See Section 11 on page 88 for more information.
Set the Match format field to the format for the match. Choices are “2 of 3”,
“3 of 5”, “4 of 7”, “5 of 9”, and “Games” (the “Games” choice is explained below).
Cantor initializes the Match format field to the match format you selected for the
event.
Enter the score for each game in the Score fields. Only enter the number of
points that the loser of each game got. If the winner of the match lost a particular
game, prefix that game’s score with a minus sign. For example, if the scores for a
match are 11–5, 10–12, 11–8, 11–3, enter “5”, “-10”, “8”, and “3”.
If you don’t know the score for a result, but you know the number of games
won and lost, you can select “Games” in the Match format field. If you don’t know
the score at all, you can check the No score check box.
Cantor will not accept partial scores, as will happen if a match is started, but
not completed because a player is injured. If this happens, enter it as a no-score
result. Do not enter defaults (where the match was not played) at all. Defaults do
not count for ratings. Matches stopped in the middle count for ratings if and only
if one of the players is able to continue, i.e., the player who can continue gets credit
for the win. So, if a match is not completed due to injury, then the winner is the
player who was not injured. If the match is not completed due to circumstances
outside the control of the players (e.g., loss of electricity), then do not enter the
match into Cantor.
Unlike most windows, the result window does not have a default button. Therefore the ⟨Enter⟩ key will behave more like the ⟨Tab⟩ key.
The result window is special in that when you press the ⟨Enter⟩ key, Cantor
tries to be smart about which field or button to move to next. If you press ⟨Enter⟩
and you’ve entered a complete result, Cantor moves you to the OK button.
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Figure 3. Result list
Click the OK button to store the result. Cantor will clear the window, but
leave it up so you can enter another result. If you do not have any more results,
you can press ⟨Enter⟩ to select the Cancel button (which is, for the moment, the
default button) to close the window. Cantor will display the new results in the main
window’s grid.
2. Modify Result
To modify a result that you’ve already entered, either double-click the result
or select the result in the grid and click the Modify Result button. This brings up
the result window (the same window you use for entering new results). Correct the
information for the result and click the OK button.
3. Print Results
Click the Print Results button to print a list of all the results in the current
event (see Figure 3). The list shows the same information that is displayed in the
result grid. The results will be in the same order as they are in the grid. So, to
change the printed order, change the order in the grid (by clicking the button in
the header of a grid column).

CHAPTER 8

Club Browser
The club browser (Figure 1) lets you view the club list and select the club of
a player or event. You can bring up the club browser from the Club > Change
button of the Edit pages of the player (::Players > Modify) and event (::Events >
Select Current) notebooks or from the ::Lists > Club menu item.
The grid works like Cantor’s other grids (see Section 9 on page 87). The Find
field lets you search for a specific club. It works like Cantor’s other incrementalsearch fields (see Section 9.1 on page 87).
If you’ve brought up the club browser by clicking the player or event Club >
Change button, then the Select Club button will be enabled. Click this button to
make the club that is selected in the grid the club of the player or event.

Figure 1. Club browser
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CHAPTER 9

Unrated Players
When Ratings Central processes an event, it first assigns a prior mean and
standard deviation to each unrated player in the event. The adjective “prior” means
that it is the player’s mean and standard deviation prior to the start of the event.
If you entered a prior mean and standard deviation for the player (in ::Players >
Modify > Edit > Unrated prior), then it uses those values. If you didn’t enter a
prior mean and standard deviation for the player, then it uses the prior mean and
standard deviation that you set for the event (in ::Events > Select Current > Edit >
Unrated prior). Note that it never uses the player’s rating (in ::Players > Modify >
Edit > Rating) for the prior.
The following sections explain how to set the individual player prior means
and standard deviations and the event prior mean and standard deviation. This will
give you an idea of how the system works. However, it isn’t easy to set good priors.
You must get our approval for the approach that you will use to set priors!
To get our approval, contact us; see https://www.ratingscentral.com/Problems.php
for our email address.
Please get unrated players at your event as many matches with rated players
of a similar playing level as you can. This will make the resulting ratings for these
players more accurate.

1. Rating Scale
The Ratings Central rating scale (i.e., what playing strength a number corresponds to) is not the same as the USATT rating scale or any other organization’s
rating scale. Unfortunately, you cannot reliably convert a USATT rating to a Ratings
Central rating because USATT ratings are inflating, have regional differences, and
vary widely in accuracy. All we can say is that a player’s USATT rating will often
(but not always) be significantly greater than their Ratings Central rating. To help
you understand the Ratings Central rating scale, we have provided videos on the
website at https://www.ratingscentral.com/Videos.php.
Ratings Central uses the same rating scale for all the table tennis sports (Table
Tennis, Hardbat Table Tennis, Sandpaper Table Tennis). If a Table Tennis player
who plays with an inverted sponge racket or a pips-out sponge racket plays Hardbat Table Tennis (with a hardbat, of course), we would expect their rating as a
Hardbat Table Tennis player to be 200 points lower than their Table Tennis rating.
If they play Sandpaper Table Tennis, we would expect their rating as a Sandpaper
Table Tennis player to be 250 points lower than their Table Tennis rating.
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2. The Fewer Priors the Better
Priors are necessary, but the fewer priors, the better. Every time you set a new
player prior or event prior, you are adding new parameters to the rating system
model. Each new parameter may be wrong or may have unintended consequences.
The best approach is to determine a single prior that describes your entire population of players, then use that single prior as the event prior for all your events and
not use player priors. If there isn’t sufficient mixing (i.e., players of different levels
playing each other), this may not work, in which case you will have to use different
priors for subpopulations.
If you are just starting to use Ratings Central, and so most of your players are
unrated, you may find that if you use one prior for everything, it takes a few events
for the ratings to become accurate. It is generally best to live with such a “burn-in”
period rather than try to use priors to make every player have an accurate rating
immediately. Letting the ratings be determined by the match results rather than
by the priors is also fairer. Backloading historical data is a good way to get things
started. Such data can also be used to evaluate the effect of different priors. We
can assist with such investigations.
The following sections explain how to set player priors and event priors. But,
to reiterate, it is best to not use player priors and to use the same event prior for
all your events. If you feel that this won’t work for your situation or if you have
already submitted events and it isn’t working, then contact us for assistance.
It isn’t easy to set good priors. You should get our approval for the priors that
you use.
3. Player Priors
The following advice for setting player priors assumes that you are very familiar with the rating scale, i.e., you know and play with many players who have
established ratings. If this is not true, then you should rely on the event prior and
rarely set individual player priors. Even if you are very familiar with the rating
scale, evaluating individual players takes effort to do well, so relying on the event
prior for some or all players can be simpler, more reliable, and fairer. If you aren’t
sure what to do, please contact us for assistance.
Despite the cautions in the previous paragraph, it can be helpful to set the
player prior mean and standard deviation for an unrated player. However, you
should only set the prior mean and standard deviation for an unrated player if
you have additional information about that player. The “additional information”
can be any information other than the player’s match wins and losses in the event
(Ratings Central sees those). For example, you might know the player from before
the event or you might watch the player play their matches or you might look at
how many points the player scored in their matches.
If a player is different from the general population of unrated players at the
event, e.g., much better or much worse (perhaps because they are very young), then
it is probably a good idea to set the player’s prior mean and standard deviation,
rather than trying to stretch the event prior to include the player.
If many or most of the players in your event are unrated, and so the unrated
players are playing mostly other unrated players, then it is probably a good idea
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to set the prior mean and standard deviation for some or many of the unrated
players.
The prior standard deviation for a player measures how sure you are that you
know that player’s playing strength. You should be willing to bet at 1:2 odds that
the player’s playing strength is within one standard deviation of the mean, and you
should be willing to bet at 2:1 odds that the player’s playing strength is more than
one standard deviation from the mean. (Odds of 1:2 mean that you win $1 if you
win the bet, but you lose $2 if you lose the bet. Odds of 2:1 mean that you win $2
if you win, but you lose $1 if you lose.)
For example, suppose you assign a prior mean of 1200 and a prior standard
deviation of 100 to a player. Then you should be willing to bet at 1:2 odds that
the player is really between 1100 and 1300, and you should be willing to bet at 2:1
odds that the player is really less than 1100 or more than 1300. Equivalently, you
should believe that there is a 2/3 chance that the player is really between 1100 and
1300 and a 1/3 chance that the player is really less than 1100 or more than 1300.
Here are some very rough guidelines: If you know an unrated player extremely
well (e.g., they’ve been playing at your club every week for a couple of years), then
you might use a prior standard deviation of 100. If you only know a player moderately well (e.g., they came to your club a few times and played several matches with
players of a similar level), then you might use a prior standard deviation of 125. If
you know very little about a player (e.g., you had the player hit with a rated player
of a similar level for five minutes), then you might use a prior standard deviation
of 175.
Be cautious using low values for prior means or for prior standard deviations,
as these can pull the ratings of other players down or make it difficult for a player’s
rating to change. It is harder to estimate the level of players below 1000 because
these players are less consistent. So, you should use larger standard deviations for
such players than you would otherwise. But, see Section 5 on the following page.
If a player has a USATT rating, then that is a source of information. However,
for the reasons mentioned above, it is not possible to simply convert USATT ratings
to Ratings Central ratings. You will have to use your judgment in how you let a
player’s USATT rating influence the prior mean and standard deviation that you
use. It is unlikely that you will want to use the player’s USATT rating as the prior
mean. Do not make the mistake of using too small a standard deviation when
relying on a player’s USATT rating.
4. Event Prior
You must always set the event prior mean and standard deviation.
While the prior mean and standard deviation for a player measure what you
know of the player’s playing strength, it is best to interpret the event prior mean
and standard deviation as describing the range of unrated players at your event.
For example, if you think the unrated players range from 800 to 1400, then you
would use the average of these two values (i.e., 1100) as the mean and the difference of these two values divided by four (i.e., 150) as the standard deviation.
More precisely, about 2/3 of the unrated players should be within one standard
deviation of the mean (and about 1/3 should be more than one standard deviation
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from the mean), 95% should be within two standard deviations, and 99.7% should
be within three standard deviations. So, for the example in the previous paragraph
of a mean of 1100 and a standard deviation of 150, you should think that
• 2/3 of the players are between 950 and 1250,
• 95% of the players are between 800 and 1400,
• 99.7% of the players are between 650 and 1550.
Note that when estimating the event prior standard deviation from the range
of players that you expect at your event, you should interpret the range as being
plus or minus two standard deviations, not three.
If you set the prior mean and standard deviation for any individual unrated
players, then the event prior mean and standard deviation should only describe the
population of unrated players for whom you haven’t set individual prior means and
standard deviations. If you set the prior mean and standard deviation individually
for every unrated player at your event, then Ratings Central won’t actually use the
event prior mean and standard deviation, but you still have to set them.
It is possible that a player that you thought was rated may become unrated
because of a correction to some other event. If this happens, the event prior mean
and standard deviation would be used for the player, even though you thought
it wouldn’t be. But, this eventuality is extremely unlikely, so not worth worrying
about.
5. Rating System Floor
While the system allows ratings to range from 1 to 3500, we don’t expect an
adult player to be less than 500. Do not set a player prior or event prior such that
the mean minus twice the standard deviation is less than 500 unless you have first
asked us and we have approved it. This applies to both adults and children.

CHAPTER 10

Submitting Events
This chapter describes what happens when you submit events.
When Cantor submits an event, it sends the following information to Ratings
Central:
• Your director ID and password from ::Cantor > Set Up.
• All information on the ::Events > Select Current > Edit notebook page
except for Match format and Status
• For each player in the event, all information on the ::Players > Modify >
Edit notebook page except for Rating, Standard deviation, and IDs > ITTF
(the Unrated prior > Mean and Unrated prior > Standard deviation are
sent)
• All results for the event, including the scores
The way that Ratings Central handles player information is a bit complicated.
To make the explanation clearer, define the player’s RC-ID-and-rating information
to be the information in the IDs > Ratings Central, Unrated prior > Mean, and Unrated prior > Standard deviation player fields. Define the player’s personal information to be the information in all the other fields that are sent to Ratings Central,
i.e., the information in the Name, IDs > USATT , IDs > TT Australia, Address 1, Address 2, City, State, Province, Postal code, Country, Email, Sex, Birth, Deceased, and
Club fields.
While Cantor sends both the RC-ID-and-rating information and the personal information for each player in the event to Ratings Central, normally Ratings Central
only copies the personal information for a player to its database if it is the first
time that it has received information for that player. The reason for this is that
suppose that you download a rating list, enter a player from the rating list in an
event, don’t make any changes to the player’s personal information that was on
the rating list, and submit the event. Also, suppose that in between the time that
you download the rating list and the time that you submit the event, some other
director makes a change to the player’s personal information. If Ratings Central
always copied the personal information to the Ratings Central database, then the
old values that you submit would overwrite the changes that the other director
made. Similarly, if you were to make a correction to an old event and resubmit it,
all the old player personal information would overwrite the current information.
The exception to this rule of not copying personal information for players already in the Ratings Central database is if you check the New personal info check
box for the player (the check box is on the ::Players > Modify > Edit notebook page).
If you check this check box, it tells Ratings Central that you have updated the
player’s personal information and that Ratings Central should replace the player’s
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personal information in its database with the information that you are submitting.
See Section 1.2.12 on page 53 for specific instructions on when you should check
the New personal info check box. You can also update a player’s personal information by logging in to the Ratings Central website. Note that there are special rules
for players with ITTF IDs; see Section 1.2.13 on page 54 for more information.
Note that the only changes to the ::Players > Modify > Edit notebook page for
a player in an already submitted event that will cause Cantor to consider the event
to be modified (and so resubmit the event) are changes to the player’s RC-ID-andrating information or checking the New personal info check box.
When Ratings Central processes an event, it assigns a Ratings Central ID number to any player in the event who doesn’t have one. You use this ID number to
identify the player in subsequent events, typically by downloading and importing
an updated rating list or by entering the ID number in the IDs > Ratings Central
field in the ::Players > Modify > Edit notebook page.
Cantor and Ratings Central keep track of which player without a Ratings Central ID is assigned which Ratings Central ID, so resubmitting an event will work
correctly, even if it contains new players that don’t have Ratings Central IDs. You
only need to use the Ratings Central ID for the player when they play in a subsequent event.
When Ratings Central finishes processing the ratings for an event, it will send
you an email like the one in Figure 1 on the next page. If there is a problem with
an event that you submit, Ratings Central will send you an email like the one in
Figure 2 on page 74.
Ratings Central will send an email to each player who played in the event to
let them know that the event has been posted. The email will contain a link to the
results on the Ratings Central website and a link so that the player can unsubscribe
from receiving future emails. Of course, the player will only receive the email if
Ratings Central has the player’s email address. At most one email will be sent to a
player for a given event. So, if you resubmit an event (to make corrections), players
who were in the first submission will not receive a second email.
When Ratings Central receives an event (or a resubmitted event), it processes
the ratings for the event and also processes all subsequent events that any of the
players in the event (or in a subsequent event that is being processed) played in.
Please be careful when viewing old events or results that you don’t click the Save
button even though you haven’t really changed anything.
Usually, it takes only a few minutes to process an event. However, the Ratings
Central processor may be busy processing other events or may need to process
other events affected by your event, so it may take longer. It won’t take more than
a day.
1. Duplicate Players
If you neglect to enter a player’s Ratings Central ID number for a player who
has one (typically because, although the player had played before, you didn’t notice
them listed on the rating list), then when you submit the event, the player will end
up in the Ratings Central database twice, i.e., there will be two Ratings Central ID
numbers that are really the same player.
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From: Ratings Central
Sent: Wed, 30 Jul 2003 21:38:26 -0400
To: David Marcus
Subject: Event processed by Ratings Central
Event: Ratings Central Open
Event date: July 20, 2003
Submitted: July 30, 2003, 9:38 pm
Status: Processed
Thank you for submitting this event to Ratings Central. We have
finished processing it.
Summary report:
https://www.ratingscentral.com/EventSummary.php?EventID=1138
Detailed report:
https://www.ratingscentral.com/EventDetail.php?EventID=1138
Here is the information that we have for you:
Name (Surname, Given): Marcus, David
Email: email@example.com
Director ID: 5044
Title:
Clubs: Boston Table Tennis Club
Address: 25 Beacon St. Apt. 16
City: Somerville
State: Massachusetts
Postal code: 02143-4336
Country: USA
Phone: 617-555-0100
Sport: Table Tennis
If any of this information is incorrect or missing, please log in to the
Ratings Central website to correct it.
Ratings Central
www.ratingscentral.com

Figure 1. Event-processed email

The way to fix this is to enter the player’s first Ratings Central ID number
(the ID number that you neglected to enter, not the new one) in the IDs > Ratings
Central field and resubmit the event. After you do this, the second ID number will
be for a player who has not played at all. The system automatically deletes players
who haven’t played.
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From: Ratings Central
Sent: Wed, 30 Jul 2003 21:13:44 -0400
To: David Marcus
Subject: Incorrect Ratings Central password
Event: Ratings Central Open
Event date: July 30, 2003
Submitted: July 30, 2003, 7:27 pm
Status: Problem
The director’s password is not correct or the director is not authorized.
Ratings Central
www.ratingscentral.com
Figure 2. Problem email
Actually, you can keep either of the two player IDs by changing the events for
the other ID and resubmitting. So, you can keep the second ID, if that is easier,
which it may be if different or multiple directors submitted events for the players.
If you need another event director to remove a duplicate, please contact them
directly. If that doesn’t work, please contact us; see https://www.ratingscentral.
com/Problems.php for our email address.
2. Wrong Date or Director ID
If you submit an event using the wrong date or wrong director ID, there are
two ways that you can fix it.
One way is to delete all the matches, resubmit the event containing no matches
(to delete it), then enter the matches into a new event on the correct date and using
the correct director ID. You can do it this way on your own. If you feel that this
method is impractical (e.g., too time consuming), there is a second way.
The second way is to contact us and request the event report file (identifying it
by date and director ID). Once you have the event report file, you can then delete all
the matches in the event in Cantor and resubmit the event containing no matches
to delete it. After you do that, you can edit the event report file to change the date
or director ID (changing them in the “[Event]” section and the filename), import it
into Cantor (see Section 5 on page 45), and submit it.
If you contact us, be sure to tell us both the wrong date and director ID and
the right ones. See https://www.ratingscentral.com/Problems.php for our email
address.
3. Lost Files
If you lose your database files, you won’t be able to resubmit events to make
corrections. To replace lost files, contact us and tell us the filename of the event
report file for each of the events that you have lost. The filenames are of the form
YYYY-MM-DD_<ID>.dat where YYYY-MM-DD is the date of the event and <ID> is
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the director ID of the event. We will send you the event report files. You can
import the files into Cantor. See Section 5 on page 45 for how to import them. See
https://www.ratingscentral.com/Problems.php for our email address.

CHAPTER 11

Mistakes and Errors
This chapter discusses Cantor’s handling of mistakes or errors in what you
type or click. To correct information that Cantor submitted to Ratings Central, see
Section 4 on page 44.
Cantor checks all values you enter or selections you make to ensure that they
are valid and consistent with all other values. On the other hand, Cantor almost
never asks you to confirm your selections, i.e., it will do what you tell it without
asking you if you really mean it. (Such confirmation dialogs rapidly become tedious
and are often ignored anyway.) If you do make a mistake, Cantor provides ways to
correct it.
If you enter a value that is not valid, Cantor displays an error-message window
(Figure 1). In this window, you cannot select the Close button by pressing ⟨Enter⟩ or
⟨Space⟩. This is so that you won’t accidentally close the window without noticing
it was there. To close the window, you can click the Close button or press the ⟨Esc⟩
key. You can also use the standard Windows ways of closing windows, i.e., click
the “×” in the title bar or press ⟨Alt+F4⟩.
You can copy the message to the clipboard via ⟨Ctrl+C⟩. You can select all
of the message text via ⟨Ctrl+A⟩. You can select part or all of the message with
the mouse. Once you click in the message with the mouse, you can use the usual
keyboard keys to change the selection, e.g., ⟨Shift+Right⟩. If part or all of the
message is selected, ⟨Ctrl+C⟩ copies the selected text to the clipboard. If nothing
is selected, then ⟨Ctrl+C⟩ copies the entire message to the clipboard.

Figure 1. Error-message window
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APPENDIX A

Who Was Cantor?
Georg Cantor (1845–1918) was a famous mathematician who founded set theory and introduced the concept of infinite numbers with his discovery of cardinal numbers. He also advanced the study of trigonometric series. Ernst Zermelo
(1871–1953) was also a famous mathematician who developed an axiom system to
lend structure to Cantor’s set theory.
Cantor (the software system) can handle results from any sort of table-tennis
event, structured or not, while Zermelo (the other software system that you can
use with Ratings Central) handles tournaments that are more structured.
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APPENDIX B

Screen Resolution and Font Size
Windows lets you set the screen resolution via Control Panel > Appearance and
Personalization > Personalization > Adjust screen resolution (this is for Windows
Vista—in other versions of Windows, the setting may be in a different place). Cantor will work at any screen resolution, but the higher the resolution, the smaller
Cantor’s text will be.
Windows also lets you set the font size (e.g., large or small fonts) via Control
Panel > Appearance and Personalization > Personalization > Adjust font size (DPI)
(again this is the Windows Vista location). However, Cantor will ignore this setting.
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APPENDIX C

User Interface
This chapter gives detailed information on Cantor’s user interface, i.e., how to
use the keyboard and mouse with Cantor.
1. Persistence
Cantor remembers the position and size of all windows, the size and order
of grid columns, which column each grid is sorted on, and the selected printer.
Cantor remembers this information both during a single invocation and between
invocations. To do this, Cantor writes the information to the file Cantor.ini in the
database folder. You can delete the Cantor.ini file if you want Cantor to revert to
the default positions, sizes, etc.
2. Basic Window Operation
The buttons in the top-right of a window’s title bar work just as they do for
other Windows applications to minimize, zoom, or close the window. You can
right-click the title bar or press ⟨Alt+Space⟩ to activate the Windows system menu.
You can close a window by pressing ⟨Alt+F4⟩. You can resize a window by dragging
its border with the mouse. A few of Cantor’s windows cannot be resized while
some others can have their width changed, but not their height. (In the latter case,
Windows doesn’t know that the window can only be resized in one dimension and
so will change the mouse cursor if you hover over any of the borders.) You can
maximize a window by double-clicking its title bar and restore it to its previous
size by double-clicking it again. And, of course, you can move a window to a new
position by dragging its title bar with the mouse.
Note that closing a window by ⟨Alt+F4⟩ or clicking the close button in the title
bar (i.e., the “×” button) is similar to clicking the Cancel or Close button (whichever
the window has). So, if you are currently editing something (e.g., an event or player),
any edits that you’ve made will be discarded. The ⟨Esc⟩ key is generally the same
as pressing the Cancel or Close button.
3. Scroll Bars
Scroll bars work just as they do for other Windows apps. Click one of the arrow
buttons to scroll one line or column. Click the area between the arrow buttons and
the thumb (i.e., the slider in the middle of the scroll bar) to scroll by one screenful.
Drag the thumb to scroll a variable amount. Scroll bars in grids work slightly
differently; see Section 9 on page 87.
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Figure 1. Window showing disabled and read-only controls
4. Focus
A control is a menu, grid, button, edit field, drop-down list, check box, radio
button, etc. The control that is currently receiving keyboard input is said to have
the focus. The ⟨Tab⟩ key moves the focus to the next control while ⟨Shift+Tab⟩
moves the focus to the previous control. Controls generally show that they have the
focus by either some sort of highlighting or by displaying a dotted focus rectangle.
Windows may hide the focus rectangle until you use the keyboard; to turn off this
“feature”, see Section 6 on the facing page.
5. Disabled and Read-Only Controls
Controls can be enabled, disabled, or read-only. When a control is disabled,
its background is the same color as the window and its label is grayed. A control will be disabled if it doesn’t currently apply. When a control is read-only, its
background is the same color as the window, but its label is displayed normally. A
control will be read-only if it does apply, but you aren’t allowed to change it.
For example, in Figure 1, the Submitted check box is read-only while the Submit
failed check box is disabled (because until an event is submitted, the submission
can’t have failed). The Club field is a bit unusual. It is shown as read-only because
you can’t change it by editing the club’s name, but you can change it by clicking on
the Change button.

6. THE MAIN MENU

85

Menu

Submenu
Keys
Modify
⟨P⟩
Players Copy from Event ⟨Y⟩
Import
⟨O⟩
Print
⟨T⟩
Select Current
⟨E⟩
Events
Submit
⟨S⟩
Import
Import
⟨I⟩
Lists
Browse Rating
⟨G⟩
Browse Club
⟨C⟩
Exit
⟨X⟩
Set Up
⟨U⟩
Set Up Internet
Cantor
Select Printer
Visit Website
⟨B⟩
Display Version
⟨V⟩
Table 1. Main-window shortcut keys

6. The Main Menu
The main menu (and Cantor’s only menu) is at the top of Cantor’s main window. Each menu and submenu item has one letter underlined.
If you don’t see the underlines, then the underlines should appear if you press
⟨Alt⟩. You can also tell Windows to always show the underlines: In Windows 10,
turn on All settings > Ease of Access > Interaction > Keyboard > Change how keyboard shortcuts work > Underline access keys when available. This setting may
also affect whether the focus rectangle is hidden until you use the keyboard.
You can select a menu or submenu item by pressing ⟨Alt⟩ and the underlined
letter. If the menu has the focus, you can just press the letter without holding
down the ⟨Alt⟩ key. You can toggle the focus between the menu and the rest of the
main window by pressing ⟨Alt⟩ or ⟨F10⟩.
If the menu has the focus, then ⟨Left⟩ moves to the previous menu item, or if
a submenu is displayed, displays the previous submenu. Similarly, ⟨Right⟩ moves
to the next menu item or submenu. ⟨Up⟩ and ⟨Down⟩ move to the previous or next
submenu item. If no submenu is displayed, then they display the submenu. ⟨Enter⟩
selects the current menu or submenu item. ⟨Esc⟩ closes a submenu. If no submenu
is open, then it gives the focus back to the rest of the main window.
Most of the submenu items have a single letter to their right. This letter specifies the shortcut key for the item. You can press the shortcut key to select the
submenu item. For example, there is a “P” next to ::Players > Modify. If you press
⟨P⟩, it is the same as clicking on Modify. The shortcut keys only work if the main
menu doesn’t have the focus (which is normally the case). Table 1 lists the menu
items and shortcut keys. The underlined letters in the table show how the shortcut
keys were chosen. The bold letters in the table show how the shortcut keys were
chosen.
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Figure 2. The Modify Result button is the default button

Each submenu has one item in bold. If you double-click a main menu item,
then the submenu item in bold will be selected.

7. Enter Key
Most windows have a default button that will be selected if you press ⟨Enter⟩
even if the button does not have the focus. For example, in Figure 2, the Modify
Result button is the default button. If there is no default button and the field that
has the focus does not respond to the ⟨Enter⟩ key, then the ⟨Enter⟩ key moves the
focus to the next field. If a button has the focus, then the ⟨Enter⟩ key always clicks
the button.

8. Accelerator Keys
Most labels have an underlined letter. (If you don’t see the underlines, see
Section 6 on the preceding page for how to tell Windows to show them.) You
can press ⟨Alt⟩ plus the key corresponding to the letter to move the focus to the
associated control. If the control you are moving to is a button, it will also be
clicked. If the control is a check box, it will be toggled (i.e., checked if unchecked
and vice versa). If the control is a radio button, it will be selected. If the control
that has the focus doesn’t respond to letter keys (e.g., a button or an edit field that
only accepts numbers), then you don’t have to hold down the ⟨Alt⟩ key—just press
the letter key. Note that drop-down lists do respond to letter keys.
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9. Grids
Cantor uses grids to display events, players, clubs, results, and submissions.
You can find grids in the main window and in ::Lists > Rating, ::Events > Select
Current, ::Players > Modify, as well as a few other places.
The selected item in a grid is indicated by a right-pointing arrowhead in the
leftmost column. If the grid has the focus, then the selected item is also highlighted.
The scroll bars in grids are standard Windows scroll bars with the following
differences: Click the area between the arrow buttons and the thumb of the horizontal scroll bar to scroll by one screenful minus one column. So, if you scroll
right (say), the last fully visible column on the right before you scroll will be the
column on the left after you scroll. Click the area between the arrow buttons and
the thumb of the vertical scroll bar to move the number of rows in one screenful.
Drag the thumb to move a variable amount.
You can resize or reorder columns by dragging with the mouse. To resize,
drag the vertical line in the header that separates two columns. To reorder, drag
the header for the column to where you want it.
You can sort the grid on a column by clicking the button to the right in the
column header. Not all columns have the button. You can only sort on columns
that do have the button. The column that the grid is currently sorted on will
display a downward-pointing arrowhead in the button. Columns with buttons will
also have an underlined letter in the column header. This indicates the accelerator
key that you can press to sort on the column. These accelerator keys work like
other accelerator keys in that you will have to also press ⟨Alt⟩ while pressing the
accelerator key if the control that currently has the focus responds to letter keys.
The sort order is decreasing for ratings and increasing for everything else.
In a grid, ⟨Up⟩ moves up one row, ⟨Down⟩ moves down one row, ⟨PgUp⟩ moves
up the number of rows in one screenful, ⟨PgDn⟩ moves down the number of rows
in one screenful, ⟨Ctrl+Home⟩ and ⟨Ctrl+PgUp⟩ scroll to the beginning, ⟨Ctrl+End⟩
and ⟨Ctrl+PgDn⟩ scroll to the end, ⟨Ctrl+Up⟩ moves to the first row displayed in the
window, ⟨Ctrl+Down⟩ moves to the last row displayed in the window, ⟨Left⟩ scrolls
the display left one grid column. ⟨Right⟩ scrolls the display right one grid column,
⟨Ctrl+Left⟩ scrolls the display left one screenful minus one column, ⟨Ctrl+Right⟩
scrolls the display right one screenful minus one column, ⟨Home⟩ scrolls all the
way to the left, and ⟨End⟩ scrolls all the way to the right. Clicking with the mouse
makes the row you clicked the current row.
In the grids on the Browse page of the player or event notebooks, you can
double-click a player or event to switch to the Edit page for the player or event.
In the result grid in the main window, you can double-click a result to modify the
result, i.e., the effect is the same as selecting a result, then clicking the Modify
Result button.
Pressing ⟨Ctrl+G⟩ sets the focus to the grid. In a Find field, pressing ⟨Up⟩
moves the focus to the grid.
9.1. Incremental Search. The player, rating list, and club grids have associated
Find fields that let you search for a specific record. These are incremental-search
fields, so you can type just the first part of what you are searching for and the grid
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will move to the first matching record. The search happens after every keystroke.
The value you type must be the sort of thing that is in the column that the grid
is sorted on. For example, if you want to search for a player by name, you must
sort the grid by name by clicking on the button in the header of the grid’s “Name”
column.
10. Drop-Down List
A drop-down list (also called a combo box) is a control that drops down a list of
choices when you click the arrow at the right of the text, e.g., ::Players > Modify >
Edit > State. With the list open or closed, ⟨Up⟩ and ⟨Left⟩ select the previous item,
⟨Right⟩ and ⟨Down⟩ select the next item, ⟨PgUp⟩ moves up the number of items in
one screenful, ⟨PgDn⟩ moves down the number of items in one screenful, ⟨Home⟩
goes all the way to the first item, ⟨End⟩ goes all the way to the last item, ⟨F4⟩,
⟨Alt+Down⟩, and ⟨Alt+Up⟩ act as toggles, opening and closing the list, and ⟨Esc⟩
closes the list without changing the selection from what it was when the list was
opened. With the list open, clicking with the mouse selects an item and ⟨Enter⟩
closes the list.
With the list either open or closed, you can also select an item by typing it
into the control. For example, to select “VA” you can type “v” or “va”. Similarly,
you can select “2” by typing “2”. In general, the list moves to the first item which
starts with the string you typed. After 1.5 seconds, the control forgets what you’ve
typed, so you can type a new string. You can also press ⟨Backspace⟩ to clear the
last character you typed.
11. List Box
Cantor uses list boxes to select the winner and loser in the New Result and
Modify Result windows. In a list box, ⟨Up⟩ selects the previous player, ⟨Down⟩
selects the next player, ⟨PgUp⟩ moves up the number of players in one screenful,
⟨PgDn⟩ moves down the number of players in one screenful, ⟨Home⟩ goes all the
way to the first player, ⟨End⟩ goes all the way to the last player. ⟨Left⟩ tabs to the
previous control, and ⟨Right⟩ tabs to the next control. Clicking with the mouse
selects a player.
You can also select a player by typing their name into the list box. For example,
to select “James”, you can type “j” or “ja”. In general, the list box moves to the first
player whose name starts with the string you typed. After 1.5 seconds, the list
box forgets what you’ve typed, so you can type a new string. You can also press
⟨Backspace⟩ to clear the last character you typed.
12. Dates and Date Fields
In grids, Cantor displays dates using the short-date format specified in your
Windows regional settings. You can change these settings in Control Panel > Regional and Language Options.
Cantor has two date fields where you can enter a date: ::Players > Modify >
Edit > Birth and ::Events > Select Current > Edit > Date. For the Birth field, use
the year-month-day order that matches your short-date Windows regional settings.
The (event) Date field displays the month name, but you can still enter the date
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into this field using numbers. However, unlike the Birth field, you must enter the
numbers in this field using the month-day-year order (since the month comes first
when the number is converted to a word).
You can use either a two-digit year or a four-digit year in either date field. For
the Birth field, Cantor assumes that a two-digit year is in the past. For the (event)
Date field, Cantor assumes that two-digit years are between eighty years ago and
twenty years from now.
In either date field, ⟨+⟩ increments the day, ⟨-⟩ decrements the day, ⟨Up⟩ increments the month, ⟨Down⟩ decrements the month, ⟨Ctrl+Up⟩ increments the year,
and ⟨Ctrl+Down⟩ decrements the year.
12.1. Calendar. You can click the button at the right of the (event) Date field
or press ⟨Alt+Down⟩ or ⟨F4⟩ to drop down a calendar. Today’s date will have a
maroon frame around it. You can select today’s date by clicking the Today button.
You can select any date by clicking a day. Click one of the buttons at the top of
the calendar to move to the previous month or next month. If you click one of the
buttons and hold the mouse down, the month will keep changing (and speed up
the longer you hold the mouse down).
You can also select the month by clicking on the header text that displays the
month name. This displays a pop-up menu that lists the months. Select the month
you want by clicking on it or by using the ⟨Up⟩, ⟨Down⟩, and ⟨Return⟩ keys. You
can also select the year by clicking on the header text that displays the year. This
displays two buttons on either side of the year. Click the left button to move to the
previous year and the right button to move to the next year. If you click one of the
buttons and hold the mouse down, the year will keep changing.
As for the keyboard, ⟨Left⟩ moves to the previous day, ⟨Right⟩ moves to the
next day, ⟨Up⟩ moves to the previous week, ⟨Down⟩ moves to the next week,
⟨Home⟩ moves to the first day of the month, ⟨End⟩ moves to the last day of the
month, ⟨PgUp⟩ moves to the previous month, ⟨PgDn⟩ moves to the next month,
⟨Esc⟩ closes the calendar without changing the date, and ⟨Return⟩ accepts the selected date and closes the calendar.
13. Buttons and Radio Buttons
If a button has the focus, you can click it via either ⟨Enter⟩ or ⟨Space⟩. If a
button has an icon, but no text, you can hover the mouse over the button to pop
up a hint that explains what the button does.
In a radio group box, you can use the ⟨Up⟩, ⟨Left⟩, ⟨Down⟩, and ⟨Right⟩ keys to
change which radio button is selected.
14. Button Edits
A button edit is an edit control that has a button as part of the control to the
right of the edit box, e.g., ::Lists > Import > Rating list. If the button edit has the
focus, you can click the button by pressing ⟨Alt+Down⟩.
15. Check Boxes
You can toggle a check box by clicking it or, if it has the focus, pressing ⟨Space⟩.
You can click the box or the text.
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16. Navigator Bar
If a navigator bar (i.e., the bar containing four buttons in the bottom left of
::Events > Select Current > Edit or ::Players > Modify > Edit) has the focus, you
can click the selected button with ⟨Space⟩ (but not ⟨Enter⟩) and select a different
button with ⟨Left⟩ or ⟨Right⟩. If you hover over a button with the mouse, Cantor
will display a hint that explains what the button does and what shortcut key you
can use to do the same thing.
The shortcut keys are ⟨PgUp⟩ moves to the previous record, ⟨PgDn⟩ moves to
the next record, ⟨Ctrl+PgUp⟩ moves to the first record, and ⟨Ctrl+PgDn⟩ moves to
the last record. These keys work regardless of which control on the Edit page has
the focus.
17. Notebooks
Notebook tabs can have the focus, just like any other control. If a notebook
tab has the focus, then ⟨Up⟩, ⟨Left⟩, and ⟨Home⟩ change to the first notebook page,
while ⟨Down⟩, ⟨Right⟩, and ⟨End⟩ change to the second notebook page (since all of
Cantor’s notebooks only have two pages).
18. Edit Fields
An edit field is a control into which you type text, numbers, or dates. In an edit
field, ⟨Del⟩ deletes the character at the caret (the caret is the vertical bar that shows
where you are in the field), ⟨Backspace⟩ deletes the character to the left of the caret,
⟨Left⟩ moves left one character, ⟨Right⟩ moves right one character, ⟨Home⟩ moves
to the beginning of the field, ⟨End⟩ moves to the end of the field, ⟨Ctrl+Left⟩ moves
left one word, ⟨Ctrl+Right⟩ moves right one word, ⟨Alt+Backspace⟩ and ⟨Ctrl+Z⟩
undo the last change you made, ⟨Ctrl+C⟩ copies the selected text to the clipboard,
⟨Ctrl+X⟩ cuts the selected text, ⟨Ctrl+V⟩ pastes, ⟨Shift+Home⟩ extends the selection
to the start of the field, ⟨Shift+End⟩ extends the selection to the end of the field,
⟨Shift+Left⟩ extends the selection left one character, ⟨Shift+Right⟩ extends the selection right one character, ⟨Ctrl+Shift+Left⟩ extends the selection left by one word,
and ⟨Ctrl+Shift+Right⟩ extends the selection right by one word.
You can also drag with the mouse to select text. If any text is selected, then
whatever you type will replace the selected text and ⟨Del⟩ and ⟨Backspace⟩ will
delete the selected text. When you move to an edit field using the keyboard, the
contents is selected, so whatever you type will replace the contents. To edit the
contents, press a key that moves the caret (e.g., ⟨Left⟩ or ⟨End⟩) or click with the
mouse to deselect the text.
19. Progress Bars
When Cantor needs to do something that may take some time, it puts up a
progress bar, e.g., Figure 3 on the next page. For some operations, it doesn’t put
up a progress bar, but does change the cursor to an hourglass. When Cantor puts
up a progress bar, you can abort the operation by clicking the Abort button or the
“×” in the window title bar, or by pressing ⟨Esc⟩, ⟨Enter⟩, or ⟨Alt+F4⟩.
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Figure 3. Progress bar

91

APPENDIX D

Database Folder
This chapter explains how Cantor finds the database folder, how you can move
the folder to a different location after Cantor is installed, how you can have more
than one event on a given date, and what to do if you have more than one director
ID. There are two ways to tell Cantor where the database folder is: setting the
current folder and using a command-line parameter.

1. Specifying the Database Folder
Whenever Windows starts an application, it designates one folder as the current folder. When you start Cantor, it looks for the database files in the current
folder. For example, if you double-click on a file with an “exe” extension, then the
current folder will be the folder containing the “exe” file. If you double-click on
a Windows shortcut (e.g., an item on the desktop that has a little arrow on the
bottom left or an item in the “Start” menu), then the current folder is determined
by the shortcut. To see or change the current folder that the shortcut is using,
right-click the shortcut and select Properties. The current folder is the folder listed
in the Start in field.
You may also specify the database folder via a command-line parameter. You
can do this by typing it in a command prompt or bat file or including it in the Target
field in a shortcut’s properties. A command-line parameter takes precedence over
the current folder. You can use the special command-line parameter “appdata” to
have Cantor put the database folder in a subfolder of your application data folder,
e.g., C:\Users\YourUserName\AppData\Roaming\RatingsCentral\Cantor.
Cantor’s installation program puts the “appdata” command-line parameter in
the shortcuts on the desktop and in the “Start” menu. So, you can move the database files to any folder you wish as long as you update the shortcuts by removing
“appdata” from the Target field and setting the Start in field to the new folder.
If you accidentally delete the shortcuts, you can create a shortcut by rightclicking the desktop and selecting New > Shortcut. This starts the Windows “Create Shortcut” wizard. For the “location of the item” (on the first page of the wizard), enter the path and filename of the Cantor.exe file, e.g., C:\Program Files (x86)
\RatingsCentral\Cantor\Cantor.exe. Click the Next button to go to the second page
of the wizard. For the name of the shortcut, enter the text that you want to appear as the caption under the desktop icon, e.g., “Cantor”. Click the Finish button.
Right-click the shortcut that you just created on the desktop and select Properties.
Change the Start in folder to the folder where you want to put the database files.
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2. Multiple Director IDs
If you need to submit two events that have the same event date, then you need
a second director ID. If the two events are related, it might make sense to combine
them into one event. But, in general, the way to submit two events on the same
date is to get a second director ID. If you aren’t sure what to do, discuss it with us;
see https://www.ratingscentral.com/Problems.php for our email address.
If you want to submit events for more than one sport, you need a director ID
for each sport. If you take over another director’s events, you will have more than
one director ID.
Each director ID must have its own set of database files. To set up Cantor to
use an additional director ID, choose a folder for the additional set of database
files, and set up a shortcut for Cantor with the Start in field set to that folder. Set
the shortcut’s caption to something that will tell you which set of database files
it is using. If you do set up an additional set of database files, be sure that you
don’t enter the same director ID into both sets of files, since this will give you two
inconsistent versions of any events that occur on the same date in both sets.
If you set up an additional set of database files, you may wish to set the list
database folder (see Section 2.2 on page 29) to something other than the database
folder. This would let you set both copies of Cantor to use the same list database
folder. So, you would only have to import the lists once rather than twice. However,
if you do this, you won’t be able to run both copies of Cantor at the same time
because only one copy of Cantor can be accessing a folder at a time.

APPENDIX E

Crashes and Bugs
If Cantor crashes, you will see a window like Figure 1. If you don’t understand
the message, then it may be a bug. You can copy the message and the details
to the clipboard by clicking the Copy Report to Clipboard button or by pressing
⟨Ctrl+C⟩. The message and details in the window will also automatically be written to the file CantorCrash.txt in the database folder. There may also be a file
CantorDatabaseError.txt that contains additional error messages.
If you wish to report a bug or have any questions or suggestions, please contact
us; see https://www.ratingscentral.com/Problems.php for our email address. If
you are reporting a bug, please include specific steps so that we can reproduce it,
send us the CantorCrash.txt and CantorDatabaseError.txt files, and also send us
the database files (if these will help us reproduce the bug).

Figure 1. Crash window
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APPENDIX F

Data Safety
The database library that Cantor uses writes all information to a journal file
before updating the database files. After updating the database files, the journal
file is deleted. This helps to prevent the files from being corrupted even if the
computer loses power in the middle of writing to the files. If writing is interrupted,
you may see a file with an n$1 extension in the database folder. This is the journal
file. When you start Cantor, it should process the journal file and delete it.
Windows provides a write-caching feature. If this feature is on, applications
may not be able to force data to be physically written to the disk and a software,
hardware, or power problem may cause data corruption. The settings are in Device
Manager. How you get to Device Manager varies in different versions of Windows.
In Windows 10, you can find Device Manager in Control Panel > Hardware and
Sound > Devices and Printers > Device Manger. Expand the Disk drives node. Right
click on your hard disk or SSD (solid state drive) and choose Properties > Policies.
The options vary in different versions of Windows. In Windows 10, you will see a
check box labeled Enable write caching on the disk and under it another one that
is labeled Turn off Windows write-cache buffer flushing on the device. Checking the
second check box is very dangerous. Checking the first is dangerous. The slight
speed increase is not worth the risk of data corruption. For safety, uncheck both
check boxes.
Some hard disks and SSDs have built-in write caching that cannot be turned
off. For safety, use a UPS (uninterruptible power supply) or both AC power and a
battery.
Antivirus apps can interfere with an app’s ability to write to the disk. For
safety, exclude the database folder from your antivirus app.
You should put the database folder on the most reliable disk that you have,
e.g., your C: drive. Using a USB key, removable disk, OneDrive folder, etc. is not
a good idea. Of course, USB keys are excellent for transferring the database files
between computers or making short-term backups. For long-term backups, CD-R
or DVD-R disks are best.
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APPENDIX G

Cost
Ratings Central uses a pay-what-you-think-is-fair fee system.
Different people use Ratings Central in different ways. Some directors have
only a few players, a few matches, and an occasional event. Others have many
players, many matches, and many events and tournaments. Some directors and
clubs are independent. Others are part of larger organizations. Some clubs and
organizations have many directors. Others have only one. Some use Cantor and
Zermelo. Others use some other method of submitting results. Some grab data
from the website for download or redisplay.
Rather than try to accommodate all the different ways that people use Ratings
Central in a fee schedule, Ratings Central uses a pay-what-you-think-is-fair fee system: Each year that you, an event director, or your players use Ratings Central, you
should pay what you think is fair, taking into account how you, your players, and
your club or organization use Ratings Central.
If you are part of a club, organization, or some other entity that has multiple
event directors, then you (the event directors) can pay as a group. If you think that
your players should contribute, then you should collect the money from them.
That is, directors should handle the payments, but directors can decide how they
raise the money within their club, organization, or tournament.
What you should pay should include what you think is fair for the use of all
aspects of Ratings Central, including the ratings, website, Cantor, Zermelo, the API,
notification emails, etc.
See https://www.ratingscentral.com/Cost.php for how to pay.
We are not going to tell you how much you should pay each year to use Ratings
Central (where “you” includes the clubs and organizations that you represent). If
you are not sure how to determine what is fair, the following may help: What is the
most that you would pay to avoid the alternative of not using Ratings Central? You
should not pay more than that. On the other hand, that is probably more than you
feel comfortable paying. So, come up with an amount that you feel is reasonable
and fair. You should be able to say to yourself, “I’m getting a good deal. I’d be
willing to pay 50% or 100% more for what I get.” But, if you can say, “Wow. I’m only
paying 5% of what I’d be willing to pay”, then do you think that is fair?
If you think that it is fair to pay nothing, then apparently Ratings Central is of
no value to you, so you should not be using it.
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log in to website, see website login
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New personal info, 44, 45, 53, 71
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event, 43
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Lists, 55, 87
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RatingList.csv, 36, 37
RatingList.nx1, 14, 29
Ratings Central
ID, see ID, Ratings Central
Read-only, 15
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event, 17, 43
player, 52, 53, 71
Status, 44, 71
Stop Importing, 38
subevent, 40
Submission method, 29
Submission.nx1, 14
Submit, 44
Submit Events, 44
Submit failed, 44, 45, 84
Submitted, 45
Submitted, 44, 84
⟨Tab⟩, 62, 84
Test, 31
thumb, 83, 87
title bar, 83
Today, 17, 89
TT Australia
ID, see ID, TT Australia
two events on same date, see multiple events
on same date
Unicode, 15
Unrated prior
event, 44, 67
player, 53, 54, 67
⟨Up⟩, 85, 87–90
Update info from rating list, 57
upgrading, 14
UPS, 97
USATT
ID, see ID, USATT
USATT membership, 55
Use authentication, 31
Use proxy server, 31
Use TLS, 13, 31
user interface, 83–90
persistence, 83
Username
Email, 31
Web proxy server, 31
VersionHistory.txt, 13
Visit Website, 32
website login, 32
window
closing, 83
resizing, 83
Winner, 19, 62
write caching, 97
wrong date, see Date, wrong
wrong director ID, see director ID, wrong
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